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Introduction

Welcome to Netscape Web Publisher and the Internet. Netscape 
Communications Corporation is the premier provider of open software that lets 
people and companies exchange information and conduct commerce over 
enterprise networks and the Internet.

This User’s Guide documents Netscape Web Publisher, which provides web 
publishing features for clients of Netscape Enterprise Server.
What’s in this book?
This manual explains how to use Netscape Web Publisher to manage files and 
folders on a remote server as well as how to use the text search, agent services, 
and access control capabilities available through Netscape Web Publisher. 

Who should read this book
This User’s Guide is a resource for content providers of documents managed by 
a Netscape Enterprise Server, version 3.0.

Conventions used in this book
This section explains the conventions used in this book.

Monospaced
font

This typeface is used for any text that appears on the computer screen or text 
that you should type. It is also used for filenames and code samples.

| The vertical bar is used as a separator for menu commands. For example, 
File|New means you should click the File menu and select the New command. 
Chapter , Introduction 9



Computer system requirements
Computer system requirements
The Netscape Web Publisher needs specific software and hardware. Before you 
can install the Web Publisher control panel, you must be using a web browser 
that supports frames, Java, and JavaScript (Netscape Navigator 3.01 or higher 
are recommended).

Note You can use MS Internet Explorer with Web Publisher, but you cannot perform 
any operations that involve local file access. Operations confined to server files 
and folders, such as copying, moving, and renaming files and folders, can be 
accomplished.

In addition, your computer must meet or exceed the following requirements.

• For the Windows platform, use one of the following:

• Windows 95

• Windows NT version 3.51 running Service Pack 4 or NT version 4.0 

• For the Macintosh PowerPC platform, use System 7.0 or later.

• For the Unix platform, use one of the following:

• Sun Solaris 2.3

• Sun Solaris 2.4 or later

• IRIX 5.2 or later

• HPUX 9.03 or later

• DEC OSF1 v2.0 or later

Contacting Technical Support
For product-specific Techncial Support assistance, please see the Product 
Support Page for Netscape Enterprise Server at http://
help.netscape.com/products/server/enterprise/index.html .

For general Technical Support assistance, please see the Netscape Techncial 
Support Page at http://help.netscape.com.
10 Netscape Web Publisher User’s Guide



C h a p t e r

1
About web server publishing
Netscape Web Publisher is a Java applet that runs on your local desktop and 
interacts with files managed by a Netscape Enterprise Server. With Web 
Publisher, you can directly access, edit, and manage documents stored on 
remote servers. Members of workgroups can seamlessly collaborate on project 
content from their desktops. Web Publisher allows you to publish a document 
to the appropriate web server with the click of a button, without using ftp  
commands or other complex interfaces.

Web Publisher provides server users with these capabilities from their 
desktops:

• file management

• version control

• editing and publishing

• search

• agent services

• controlling access

• link management

This chapter introduces these features of Web Publisher and provides an 
overview of web server publishing.
Chapter 1, About web server publishing 11



File management
File management
Netscape Web Publisher allows you to manage remote server files and folders. 
You have easy access to the server’s files and folders through a hierarchical list 
in the Web Publisher file management window. You can copy, move, rename, 
and delete files and directories. You can also download server files to your 
local system and upload your local files to the server. 

Each file and folder on the server has a set of properties that describe 
information about a file such as its filename, owner, lock status, size, and 
creation date, and this information is updated whenever the file is edited or 
added to the server. 

You can perform a search on any of these file properties. For example, you can 
search for all files that belong to a certain author, for all the locked files, or for 
any file with a particular string in the title field.

Version control
Netscape Web Publisher includes a version control system for keeping track of 
documents as they are updated and changed. Once version control is started 
for a document, Web Publisher manages its version control for you, providing 
its version history, allowing you to compare different versions, and automati-
cally incrementing its version numbers when users publish new versions.

You can place a file under version control by manually starting version control 
for any file listed in the Web Publisher file management window. You can also 
direct Web Publisher to automatically start versioning for a file by setting an 
option when you edit the file or when you upload a local file to the server. 

The latest version of a file is the one that is available “live” on the web server, 
but you still have access to previous versions by using Web Publisher in these 
ways:

• You can view a file’s version history.

• You can compare two versions for differences.

• You can view earlier versions.
12 Netscape Web Publisher User’s Guide



Editing and publishing
Editing and publishing
With Web Publisher, you can edit server files in a variety of different formats, 
automatically launching the application associated with the file, such as 
Netscape Composer for HTML files, Adobe Acrobat for PDF files, and Microsoft 
Excel for spreadsheet files. 

You can configure Web Publisher to associate an editor program with a specific 
file type. For example, if you edit an HTML file or an ASCII file, Web Publisher 
defaults to opening the file in a Netscape HTML editor. If you edit a non-HTML 
file, Web Publisher launches the application associated with that file type. For 
example, if Microsoft Excel is associated with files that use the .xls extension, 
when you edit such files, Microsoft Excel is launched and you can work in 
Excel, saving the file as usual when you are done making changes.

When you edit a server file, Web Publisher places a small pen icon next to it in 
the Web Publisher applet window. During the edit, the file is in an “edit state,” 
which locks it so that other users cannot write to it, although they can still 
browse it. To make your new changes publicly available to other users on the 
server, you must publish the edited file back to the server. This updates the 
server file and makes it available to other users again. 

As part of the process of publishing an edited file back to the web server, Web 
Publisher performs these tasks:

• unlocks the file

• updates the server file, making the revised file available for other users

• updates links to and from the file

• updates the file’s properties, such as a new modification date

• for files under version control, increments the file’s version number by 0.1 
and updates its version history

• updates the file’s properties and content for searching
Chapter 1, About web server publishing 13



Search
Search
With Netscape Web Publisher, you can search through the contents and file 
properties of documents on a remote server. For example, you can search for 
documents created after a certain date or for documents that contain the word 
web. 

For more information about the Web Publisher search function, see Chapter 5, 
“Search.”

Agent services
With Netscape Web Publisher, you can create server agents that can perform 
actions automatically for you. In some situations, you may want the Enterprise 
Server to perform a task without requiring you to interact directly with the 
server. For example, you may want to get an email every week listing the most 
recently updated web pages without having to start your browser, access the 
server, and perform a search. 

There are two basic types of events that agents respond to:

• Document events. These events are based on the state or properties of a 
document or directory served by the Enterprise Server. For example, an 
event might be the removal of a directory or the modification of a 
document. 

• Timer events. These events are based on a specific point in time (for 
example, Monday, November 3, 1997 at 12 p.m.) or a recurring period of 
time (every day, every week, every month). Search agents can be defined to 
perform a specific search on a regular ongoing basis (for example, every 
Sunday at 11 p.m., find all documents that have been updated during the 
past week).

For more information about agent services, see Chapter 6, “Agents.”
14 Netscape Web Publisher User’s Guide



Controlling access
Controlling access
Netscape Web Publisher lets you control access to your Web Publisher files and 
folders. You can permit different users to have different types of access to your 
files and folders (for example, allowing one user only to read files, while 
another user can write or delete your files). You can define which documents 
an agent can monitor and you can restrict which documents you can search 
through.

For more information about setting access permissions, see Chapter 7, “Access 
control.”

Link management
Netscape Web Publisher provides automatic link management functions for 
you. Whenever you upload or publish a document, Web Publisher checks its 
links and updates the information in the link status database. Depending on 
how your server administrator sets up your server, when you copy, move, or 
rename files or folders, Web Publisher updates outgoing and incoming links 
between files on the same server so that the links still point to the same 
documents. 

For more information about link management, see Chapter 8, “Managing links.”
Chapter 1, About web server publishing 15
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C h a p t e r

2
Installing and configuring
Netscape Web Publisher is a Java applet that provides convenient client access 
to web server publishing. The default installation of a Netscape Enterprise 3.0 
server includes the Web Publisher applet with a home page. 

This chapter discusses some basic information about installing and configuring 
Web Publisher and describes issues specific to the version of Netscape 
Navigator you are using. 

There are two plug-ins: one for users of Netscape Navigator version 3.01 and 
an optional plug-in for users of the Netscape Composer component of 
Netscape Communicator. If you are using version 3.01 of Netscape Navigator 
and want to be able to use all of the Web Publisher functions, you need the 
Web Publisher plug-in. If you are using Netscape Communicator, the plug-in 
enhances the Composer’s editing and publishing capabilities to provide more 
seamless client access to server documents and folders.

The Web Publisher home page
The Web Publisher home page is included as part of the default Enterprise 
Server installation. From this page, you can launch Web Publisher, define the 
web publishing document directory, download the plug-ins appropriate for 
your system, and access online help.
Chapter 2, Installing and configuring 17



The Web Publisher console window
To locate the Web Publisher home page, type in this URL: 

http:// yourServer /publisher

This displays the Web Publisher home page, which has a Start Web Publisher 
button as well as useful links:one for downloading the plug-in and several for 
accessing the online help system. After installing the plug-in for your system, 
you can start up Web Publisher from this page. 

When you start up Web Publisher, you need to identify which document 
directory you want it to use. By default, Web Publisher has the primary 
document directory as its scope. Yo u can change this to point at a different 
folder on your server by choosing one from the drop-down list or by directly 
typing in the folder you want to use. Whichever folder you enter becomes 
added to the drop-down list for your future convenience. The list can hold 10 
folders. If you add additional folders, the first ones you entered are deleted 
from the list.

The Web Publisher console window
When you start up Web Publisher, a special Web Publisher browser window 
appears on your screen, as shown in Figure 2.1, that provides a Java 
environment for Web Publisher. This browser window must remain open in 
order for you to be able to run Web Publisher.

Figure 2.1  The Web Publisher console window
18 Netscape Web Publisher User’s Guide



Configuring Web Publisher
Configuring Web Publisher
There are two configuration files that determine how Web Publisher works. 
One file, editor.txt , associates file types with applications that are to be 
launched when you open a file for editing. The other, nswppref.txt , stores 
information about your Web Publisher session such as your user name, 
window size, user preferences,and files being edited. These files are stored 
locally in your system in the folder that contains your Netscape Navigator 
program. For example, for a Windows user it might be in C:\Program 
Files\Netscape\Navigator . 

Users of Netscape Navigator 3 need to set up their editor.txt file when they first 
use Web Publisher, but otherwise users do not need to modify these files. 
There are, however, some circumstances when you may want to make changes 
to these files. This section describes when and how to do this.

The editor preferences file

Netscape Web Publisher allows you to associate a particular application with a 
given file type. When you edit a file, Web Publisher launches its associated 
application, which could be MS Word, MW Excel, Netscape Navigator’s HTML 
Editor, or some other program.

The editor.txt  file identifies which programs Web Publisher should use to 
edit files in different formats. By default there are entries in the editor 
preferences file to open HTML files in the editor part of your Netscape 
program, but you can add as many as you need to edit each of the different file 
types you work with. For example, if you have MS Word documents or GIF 
graphic files, you can edit them in MS Word or PaintShop Pro, respectively. 

Users of Netscape Navigator use their local text editor to edit the file, while 
users of Netscape Communicator edit the file with the Edit | Preferences | 
Editors menu command (which modifies the editor.txt file for you).

For Communicator users

To define editor applications, use the Edit menu to access the Editors 
preference. This command displays a dialog box listng your editor preferences, 
which initially includes entries for HTML files with the html  and htm  exten-
sions.
Chapter 2, Installing and configuring 19



Configuring Web Publisher
To add other entries, follow these steps:

1. Click the Add New button. The Set Editor Program dialog box is displayed.

2. Enter the file extension for the given file type, either without or without the 
preceding period. That is, you could type doc  or .doc  to define an editor 
for word processing documents. 

3. Enter the exact line of code to launch the editor. In many cases this will 
simply be the full pathname for the executable program file. For example:

C:\msoffice\winword\winword.exe

In other cases, you may need to enter a command that includes arguments 
or options. You can use the %f symbolic name to insert the file’s name into 
the command line, or %u to include the server URL.

4. Click the option “Use Communicator to edit directly on the server” if you do 
not want to create a temporary copy of the edited file on your local system 
during the editing process. 

For Navigator 3 users

To define editor applications, use your local text editor to modify the 
editor.txt  file to reflect your preferred choices. This file is located in the 
WebPub directory under your Netscape Navigator directory. For example, in 
the C:\Program Files\Netscape\WebPub  directory.

Warning Many Windows systems use the 8.3 MS-DOS filename convention, which 
cannot handle filenames longer than 8 characters or filenames that contains 
spaces. This means that a Windows directory such as 

C:\Program Files\Netscape301\WebPub

should be defined in your editor.txt  file as the following:

C:\\Progra~1\\Netsca~1\\WebPub

The editor.txt  file for a Windows NT system requires double backward 
slashes between parts of the pathname. A sample editor.txt  file looks like 
this:

editor.htm=c:\\Program Files\\netscape\\program\\netscape.exe -edit
editor.html=c:\\Program Files\\netscape\\program\\netscape.exe -edit
20 Netscape Web Publisher User’s Guide



Configuring Web Publisher
editor.doc=c:\\msoffice\\winword\\winword.exe
editor.txt=c:\\winnt35\\notepad.exe

or with the 8.3 file notation:

editor.htm=c:\\progra~1\\netscape\\program\\netscape.exe -edit
editor.html=c:\\progra~1\\netscape\\program\\netscape.exe -edit
editor.doc=c:\\msoffice\\winword\\winword.exe
editor.txt=c:\\winnt35\\notepad.exe

A sample editor.txt  file for a typical Unix system looks like this:

editor.htm=/usr/bin/xterm -e vi
editor.html=/usr/bin/xterm -e vi
editor.txt=/usr/bin/xterm -e vi

The Web Publisher preferences file
The nswppref.txt  file defines your Web Publisher session. There are many 
program details listed in the file that define internal configurations, such as the 
size of applet window, and there are others that your the various Edit | 
Preferences menu commands define for you. Normally you do not need to 
make any modifications to this file.

There is one situation in which you might need to manually change to this file. 
This occurs when an unexpected file is listed in the Publish All Edited Files 
dialog box. This might happen when a user manually unlock an “in edit” file 
through the Properties page or when a Navigator 3 user attempts to cancel an 
editing operation by clicking Cancel on any but the first the local file access 
dialog box. 

Generally executing the Publish command takes the file out of the “in edit” 
state and restores to the server. For version controlled files, however, this 
results in an additional version being incremented in your version history. If 
you wish to avoid this, you can manually modify your Web Publisher 
preferences file to remove the “in edit” flag from this file.

To do this, use your local text editor to edit the file. The file will have one or 
more lines at the end that read like this:

EDITED: http:// yourServer /TempDir/myFile.html
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These entries indicate which files are still being edited, that is, they have not yet 
been published back to the server. If you need to manually release a file from 
the “in edit” state, you simply delete the offending line. Save the file and return 
to the Web Publisher applet to see that the file no longer appears as an edited 
file.

User access requirements
In order to use Web Publisher, you must be defined as a valid user with basic 
read or read-write permissions for a Netscape Enterprise 3.0 server. See your 
server administrator if you have any questions about your user privileges. 

The default access control for a Netscape Enterprise 3.0 server is to permit any 
defined user to have write privileges to the server’s files. Your server 
administrator can adjust this for a specific server. You can also adjust this for 
individual files and folders that you own by using Web Publisher’s access 
control function. See Chapter 7, “Access control,” for more information.

For Communicator and Composer users
This section applies only to Web Publisher users who are using Netscape 
Communicator and its Composer component.

Enabling Java

Netscape Web Publisher requires that you have Java enabled in your browser 
in order for the applet to run. To enable Java in the Netscape Navigator 
component of Netscape Communicator, do the following:

1. From the Edit menu, choose Preferences.

2. Select the Advanced set of preferences.

3. Click Enable Java. 
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Installing the Composer plug-in

With the Composer plug-in, you can seamlessly edit and publish files on 
remote web servers. This is an optional plug-in that adds special web 
publishing capabilities to the editing and publishing functions. It also adds the 
Web Publisher Lock and Unlock menu commands to the Tools menu, which 
allows Composer users to lock and unlock remote files. In this way, you can 
perform web server publishing directly from the Communicator software on 
your local desktop.

The instructions listed here for installing the Composer plug-in assume that 
your Netscape Communicator installation is in the default directory. For 
example, on a typical Windows system, the default document directory would 
be:

C:\Program Files\Netscape\Navigator

If you are using a different directory, be sure to adjust the paths as you install 
the plug-in.

To install the Composer plug-in, go to the Web Publisher home page, as 
described in “The Web Publisher home page,” and follow the instructions there 
to download the plug-in. When you have installed the plug-in, you must restart 
Communicator to use the web publishing features in Composer. 

Java security certificates

Netscape Web Publisher is a signed applet that requires Netscape 
Communicator users to grant access through a Java Security certificate. The first 
time you attempt a Web Publisher operation that accesses local files, a window 
is displayed that provides details of the local file access operation and requests 
that you grant or deny access to the applet.

If you check the box to “Remember this decision each time I start 
Communicator,” the Java security checking is handled afterwards in the 
background for you. 
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Page services menu command

If you are browsing a server document in the Navigator component of Netscape 
Commmunicator, you can quickly access the file’s web publishing information 
in the Web Publisher Services page by using the page services menu command.

To do this, follow these steps:

1. Open a server document in the Netscape Navigator browser window.

2. From the View menu, choose the page services command.

The Web Publisher Services form is displayed, providing the Properties page 
for the document you are browsing. You can use any of these web publishing 
features:

• search

• agent services

• access control

• online help

• the Web Publisher applet (this launches it if you haven’t already)

For Navigator 3 users
This section applies only to Web Publisher users who are using version 3.01 of 
Netscape Navigator

Enabling Java

Netscape Web Publisher requires that you have Java enabled in your browser 
in order for the applet to run. To enable Java in Netscape Navigator 3.01, do 
the following:

1. From the Options menu, choose Network Preferences.

2. Select the Languages tab.
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3. Click Enable Java.

Installing the Web Publisher plug-in
To preserve the security of your machine’s files in pre-Communicator versions 
of Netscape Navigator, unauthenticated Java applets cannot access local files. In 
order to use the Web Publisher features that involve accessing local files, you 
need to install plug-in software that provides additional security procedures to 
allow local file access under special circumstances. Once you’ve installed the 
plug-in, Web Publisher prompts you to confirm your actions when you read 
and write files on your local drive. This includes editing files because they are 
temporarily stored on your local system while you are editing them.

You can use most of the functions of Web Publisher, such as copy and move 
files, without the plug-in, but the publishing and version control functions are 
disabled. 

The instructions listed here for installing the plug-in assume that your 
installation is in the default directory. For example, on a typical Windows 
system, the default document directory would be:

C:\Program Files\Netscape\Navigator

If you are using a different directory for Netscape Navigator, be sure to adjust 
the paths as you install the plug-in.

To install the plug-in, go to the Web Publisher home page, as described in “The 
Web Publisher home page,” and follow the instructions there to download the 
plug-in. When you have installed the plug-in, you must restart Navigator to use 
Web Publisher with all its features enabled by the plug-in.

You can check if the plug-in has been installed by going to the Help menu in 
your Netscape Navigator browser window and choose the About Plug-ins 
command. The plug-in should be listed there, as shown in Figure 2.1.
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Figure 2.2  The Web Publisher plug-in installed 

Local file access checks

Because Web Publisher is a Java applet, it does not allow access to local files 
and folders. The Web Publisher plug-in permits local file access, but requires 
you to confirm all such operations.

In Netscape Navigator 3.01, for example, when you want to edit a file, Web 
Publisher displays a set of dialog boxes such as those shown here in Figure 2.3 
and Figure 2.4. An edited file is considered to be a “local” file because Web 
Publisher places a temporary copy of the file on your local system while you 
are editing it. 

Figure 2.3  The local file write confirmation dialog box 

Figure 2.3 shows the dialog box for confirmation before trying to modify a file, 
and Figure 2.4 shows the dialog box checking for permission to edit the file. 
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Figure 2.4  The local file edit confirmation dialog box 

You may get an additional dialog box if the temporary directory for storing files 
while they are being edited does not yet exist. Web Publisher will create the 
directory for you, but you must confirm that it is okay.
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3
Web Publisher QuickStart
Netscape Web Publisher lets server clients directly access, edit, and manage 
files and folders on remote servers. In this way, multiple users can collaborate 
on shared workgroup web server documents from their desktops. 

This chapter focuses on a few of the most common tasks to get you up and 
running as quickly as possible. Chapters 4 through 8 describe the Web 
Publisher services and menu commands in detail. 

Typical Web Publisher users need to:

• understand the Web Publisher interface

• edit a server file

• add a new file to the server

• view a file’s information: its properties and version history

• check a file’s links

The search, access control, and agents components of Web Publisher are 
discussed in other chapters. For search, see Chapter 5, “Search.” For agent 
services, see Chapter 6, “Agents.” For access control, see Chapter 7, “Access 
control.” 
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Note Web Publisher provides many internal and automatic features such as link 
management, file reindexing, and state checking. If you use your local file 
management tools to manipulate files and folders in the document directory 
defined for Web Publisher, you may get inconsistent and unexpected results. 

Using the Web Publisher interface
When you start up Web Publisher, you see the server documents and folders 
displayed in a window that hierarchically lists all files and folders, as shown in 
Figure 3.1. There are several icons that provide information about a given file 
or folder. 

Figure 3.1  The Web Publisher window 
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Web Publisher icons

As files undergo different operations, Web Publisher displays different icons in 
the Web Publisher window. Version control is indicated by a small document 
stack. Files that you have edited but haven’t yet published have a distinctive 
pen icon. Locked files also have special icons that differ depending on whether 
you or another user is the lock owner. Table 3.1 shows the various possible 
combinations. 

When a file that is being edited is published back to the server, the pen icon 
disappears. Likewise, when files that have been locked are unlocked, the lock 
icon or the circle icon disappears.

Sorting the listed files and folders

You can choose to sort the files and folders in different ascending or 
descending sort sequences: by name, modification date, or size. 

To sort the files, click the heading for the column you want to sort by. 
Alternately, you can go to the View menu and choose the Sort command, 
selecting the appropriate sort sequence from the submenu (name, date, or 
size).

Table 3.1 File icons for different operations

Operation Without version control With version control

(no operation)

edited by you

locked by you

locked by another user
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Keyboard shortcuts

Web Publisher uses many standard keyboard actions:

• If you double-click a file, it opens in a web browser window.

• If you double-click a folder, it opens (or closes if already open). 

• If you click the small plus or minus sign in the list next to a folder, it opens 
(or closes if already open).

• You can select a file or folder and move it to a new location by using the 
drag-and-drop method.

• You can select a file or folder and make a copy of it in a new location by 
pressing the Control key while you use the drag-and-drop method.

• You may sometimes need to move the cursor on the screen to refresh an 
hourglass cursor, updating it to an arrow cursor once more.

Toolbar shortcuts

At the top of the Web Publisher file management window, the toolbar presents 
seven buttons as shortcuts for the most commonly used Web Publisher 
commands, as shown in Figure 3.2. The complete set of menu commands are 
described in Chapter 4, “Services and menus.” 

Figure 3.2  The toolbar 

You can select a file or folder and use a toolbar button to execute a Web 
Publisher command. From left, the icons are:

• Open folder: opens the selected folder.

• New folder: creates a new folder within the selected directory.

• Browse file: opens the selected file in a web browser window.
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• Edit file: opens the selected file in an editor window.

• Publish file: allows you to publish an edited file back to the server. 

• Information: opens the Web Publisher Services page, displaying information 
about the selected file or folder.

• Search: launches the Web Publisher search interface.

Editing a server file
This section describes how to edit a file stored on a remote web server and 
publish the modified file back to the server so that it is available for other users. 
When you edit a file, it becomes locked to other users until you have published 
it. 

With Web Publisher, you can edit any unlocked file that you have read and 
write permission for. Members of a workgroup often need to be able to make 
changes to shared files on a remote server as they collaborate on a project. 

To edit a file:

1. Select an unlocked file.

2. Click the Edit toolbar button. 

3. Click OK to launch the file’s editor application and begin editing the file. 

Depending on how your editor.txt file is set up, this command may launch 
Netscape Navigator’s HTML editor, Adobe Acrobat, Microsoft Word or Excel, 
a simple text editor, or another application that you have associated with 
this particular file’s format. See Chapter 2, “Installing and configuring” for 
more information about setting up file editors. 

4. When you have made your changes, save the file in the editor application. 
If you are using the HTML editor in Netscape Navigator 3.01, do not use its 
Publish command. 

The new version is not available on the server for other users until you publish 
it. To publish an edited file to the server:

1. Select the edited file.
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2. From the File menu, choose the Publish an Edited File command. The 
Publish File dialog box appears.

3. To add your own comments for a file that is under version control, you can 
type text into the Comments field.

4. Click OK to publish the file.

The edited file is again available on the server. Web Publisher unlocks the file 
and updates the version number for files under version control.

Adding a new file to the server
Another common task is to add a new file to the server by uploading a local 
file. Whether the file is an application, a word processing document, a PDF file, 
a spreadsheet, or an HTML file—you can add it to the server with Web 
Publisher. Using the file filters, files in many different formats can be automati-
cally converted to HTML for you. See Chapter 5, “Search” for more information 
about file filters.

To move one of your local files onto the server and have the file placed under 
version control, do the following:

1. In the Web Publisher window, select the folder where you want to place 
your new file. 
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2. From the File menu, choose the Upload to Server menu command. The 
Upload File or Folder dialog box appears.

3. In the Upload Local File or Folder field, type the full pathname of your local 
file. If you are using Communicator, you can click the Browse button to 
look for the file on your local system.

4. Your destination folder’s pathname appears in the To Server File or Folder 
field. You can also change the destination that appears. 

5. You can optionally start version control for this file, by checking the “Start 
version control on uploaded files” option. The default is to start version 
control. 

6. You can lock a file when you put it on the server by checking the “Lock 
files after upload” option. The default is not to lock files.

7. Click Upload to add your local file to the server.

8. A dialog box is displayed asking you to update the file properties for this 
file. Click OK to go to the Web Publisher Services page with the Properties 
for this file.

Viewing a file’s information
You can view a file’s default and custom properties as well as its version history 
from the Web Publisher Services page. You can also check a file’s links from 
this page.
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Figure 3.3  The Web Publisher Services page 

File properties

There are two types of file properties: default and custom properties. Each Web 
Publisher file has a set of default properties, and these are displayed when you 
click the Properties link. You can only modify the owner of a file, and then 
only if you are the assigned owner or the file has no owner. Your server 
administrator can also define some custom properties and these are displayed 
when you click the Custom Properties link. You can enter your own values for 
any property that has been designated as modifiable by your server 
administrator.

Default properties

To see the default properties , follow these steps:

1. Select a file from the Web Publisher window .
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2. Click the Information toolbar button or choose the Properties command 
from the View menu. The Web Publisher Services form is displayed with the 
file’s properties page visible.

3. If the file’s properties are not visible, click the Properties link to display 
them.

Files have the set of default properties listed here. Folders have only two 
modifiable properties, Description and Owner, and four read-only properties: 
Filename, URL, Size, and Modified. Also see Chapter 4, “Services and menus,” 
for information about properties.

• Owner—The user name assigned to the file. Only owners can modify this 
field. If a file has no owner, anyone can define themselves as owner. See 
Chapter 7, “Access Control,” for more information about file ownership.

• Title: The HTML title, as tagged with the HTML tag of <TITLE> . This 
property is only available when the file’s content is made searchable.

• Author: The file’s author, as tagged with the HTML tag of <META 
NAME="Author"> . This property is only available when the file’s content 
is made searchable.

• Description—A description for the file, as tagged with the HTML tag of 
<META NAME="Description"> . This property is only available when 
the file’s content is made searchable.

• Lock-Status—The current lock status for the file. If a file is locked, only the 
lock owner can unlock it. 

• Lock-Owner—The user name for the user that locked the file. Only the lock 
owner can unlock a file.

• Filename—The name of the file. 

• Path—The relative filename for the file. This is the filename without the 
root directory. 

• URL—The file’s full pathname. 

• Size—The size, in bytes, of the file. 

• Created—The date when the file was created.

• Modified—The date when the file was last modified.
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• Searchable Contents—A flag indicating whether or not the contents are 
searchable. The default is Yes. 

You can perform a search on any property as well as on any searchable file 
contents. For example, you can search for all files that belong to a certain 
author, for all the locked files, or for any file with a particular string in the title 
field. For more information about doing searches, see Chapter 5, “Search.” 

Custom properties

To see the default properties , follow these steps:

1. Select a file from the Web Publisher window .

2. Click the Information toolbar button or choose the Properties command 
from the View menu. The Web Publisher Services form is displayed with the 
file’s properties page visible.

3. Cick the Custom Properties link. A list of properties with their current 
values is displayed.

Version history

In Web Publisher, all files placed under version control begin with version 1.1, 
and each subsequent time you edit and then publish the file, the version 
number is incremented by 0.1. Once a file is under version control, Web 
Publisher maintains a record of each version of a file and gives you access to its 
versions.

To view a file’s version history, do the following:

1. Begin by viewing a file’s information through the Web Publisher Services 
page as described in the previous set of steps, in the section “File 
properties.” 
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2. Click the Version History link in the left frame. The version history for a file 
is displayed in the right frame. 

The history consists of a series of version information sections, one per version. 
Each section has this information:

• Version—The version number. This is initially set to v1.1 and is 
incremented each time the file is published. Click this link to view the 
version.

• Modified By—The user ID of the person who was the last person to publish 
the file or who set up version control for this file, whichever is more recent. 

• Last Modified—The date of the latest file modification, which is the creation 
date for new files. 

• Comments—The text entered when the latest version was created. This 
initially contains text generated by Web Publisher, but when you later 
publish the file, creating additional versions, you can input your own 
comments here.

You can also compare different versions of a file, by following these steps:

1. Begin by viewing a file’s information through the Web Publisher Services 
page as described in the section “File properties.” 

2. Click the Version History link. At the top of the version history page, there 
is a section for comparing versions.

3. From the two drop-down lists, select the two versions you want to 
compare. The version selected from the left-hand list is taken as the starting 
point from which the other version is compared for additions (in green) and 
deletions (in red). 
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4. Click Compare.

The output is an HTML file in your web browser window that highlights where 
the versions differ, with green text and arrows to mark added text and graphic 
objects and red text and arrows to mark deletions.

Checking a file’s links
You can check the status of all the links in a file’s or all the links in all the files 
within a folder. There are two ways to obtain the check links page: through a 
link on the Web Publisher Services form or with a menu command.

If you are already viewing a file’s information through the Web Publisher 
Services page, you can follow these steps to check the file’s links:

1. Click the Check Links link in the left frame. A Link Status page similar to the 
one in Figure 3.4 is displayed for files whose links have never been 
checked.

Figure 3.4  The link status for an unchecked file

2. Click Check Links. A list of all the outgoing links in your file is displayed, as 
shown in Figure 3.5. This lists all the working, broken, and external links 
for your file. 
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Figure 3.5  The list of a file’s links 

3. When you check links again for this file, this list will be displayed. If you 
think your links may have changed since the last time you checked them, 
you can click Check Links to obtain a current link status list.

If you are not in the Web Publisher Services form, you can use the applet’s 
menu command to check a file’s links. To do this, follow these steps:

1. Select a file or folder in the Web Publisher window.

2. From the Services menu, choose Check Links. The Link Status page is 
displayed. If you have not yet checked the links for this file, you see a page 
like that shown in Figure 3.4.

3. If you are checking the links for a file whose links have already been 
checked, you see a list like that in Figure 3.5. This lists all the working, 
broken, and external links for your file. 

4. To be sure the file’s links are up to date, you can recheck them by clicking 
Check Links.

You can also check the links in a folder as well as produce a report on the 
broken links in all the files within a folder. See Chapter 8, “Managing links,” for 
more information about link management.
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4w
Services and menus
Overview
Netscape Web Publisher provides many sophisticated file and link management 
functions. There are two ways to access much of this functionality: through 
links and buttons on the Web Publisher Services page and through the Web 
Publisher menu commands. This chapter describes the Web Publisher Services 
page and then the menus, with each command described in the order in which 
it appears on the menu. 

This chapter discusses these links and buttons on the Web Publisher Services 
page:

• Web Publisher Services page: Properties, Version History, Check Links, 
Custom Properties, Web Publisher, Agents, Access Control, Search, and 
Help.

This chapter also provides details for these menus and commands:

• File: New Folder, Open Folder, Open File in Browser, Open File in Editor, 
Cancel Editing, Publish Edited File, Publish All Edited Files, Upload to 
Server, Download From Server, Exit

• Edit: Lock, Unlock, Copy To, Move To, Rename, Delete, Preferences

• View: Properties, Sort By, Redraw Window, Reload Window, Show Toolbar, 
Hide Toolbar
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• Services: Start Version Control, Stop Version Control

The functional areas of search, agent services, access control, and link 
management are described in separate chapters. For text search, see 
Chapter 5, “Search.” For agent services, see Chapter 6, “Agents.” For access 
control, see Chapter 7, “Access control.” For link management, see 
Chapter 8, “Managing links.”

Web Publisher Services page
The Web Publisher Services page provides many file management functions in 
a single form plus providing direct access to agent services, access control, 
search, and help. This section describes the functions and services available 
from this page. 

To display the Web Publisher Services page, do the following:

1. Select a file or folder in the Web Publisher window.

2. Click the Information toolbar button or choose Properties from the View 
menu. The Web Publisher Services page is displayed with the file’s 
properties visible.

Note Users of Netscape Communicator can choose the Page Services command from 
the Communicator’s View menu to display the Web Publisher Services page for 
the file currently being browsed. 
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Figure 4.1 The Web Publisher Services page 

Properties

Web Publisher files and folders have a set of default properties that describe 
many of their attributes. For example, when a file was created, who the lock 
owner is, and what its URL is. 

To access the properties for a file or folder from Web Publisher, do the 
following:

1. Select the file or folder in the Web Publisher window.

2. Click the Information toolbar button or choose Properties from the View 
menu. The Web Publisher Services page is displayed with the file’s 
properties visible.

To access the properties for a file or folder through the Web Publisher Services 
page, do the following:
Chapter 4, Services and menus 45



Web Publisher Services page
1. Click the Properties link. The Netscape Web Publisher Services window 
appears with the file or folder properties in the right frame.

Figure 4.2  The Properties for a file 

Files have the set of default properties listed here. Folders have only two 
modifiable properties, Description and Owner, and four read-only properties: 
Filename, URL, Size, and Modified.

• Owner—The user name assigned to the file. Only owners can modify this 
field. If a file has no owner, anyone can define themselves as owner. See 
Chapter 7, “Access Control,” for more information about file ownership.

• Title: The HTML title, as tagged with the HTML tag of <TITLE> . This 
property is only available when the file’s content is made searchable.

• Author: The file’s author, as tagged with the HTML tag of <META 
NAME="Author"> . This property is only available when the file’s content 
is made searchable.

• Description—A description for the file, as tagged with the HTML tag of 
<META NAME="Description"> . This property is only available when 
the file’s content is made searchable.

• Lock-Status—The current lock status for the file. If a file is locked, only the 
lock owner can unlock it. 
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Note If a file is in an “edit” state, it is displayed as locked. Do not unlock it from this 
form because although the file would now appear as no longer locked or in an 
“edit “ state, it still must be published (with the Publish All Edited Files 
command) before it is available to other users.

• Lock-Owner—The user name for the user that locked the file. Only the lock 
owner can unlock a file.

• Filename—The name of the file. 

• Path—The relative filename for the file. This is the filename without the 
root directory. 

• URL—The file’s full pathname. 

• Size—The size, in bytes, of the file. 

• Created—The date when the file was created.

• Modified—The date when the file was last modified.

• Searchable Contents—A flag indicating whether or not the contents are 
searchable. The default is Yes. If set to No, you can make the contents 
searchable by clicking the “Make contents searchable” checkbox. After you 
click Modify, the file contents are available for searching.

If set to Yes, you can make contents no longer searchable by clicking the 
checkbox. After you click Modify, the file contents are no longer available 
for searching.

You can perform a search on any property as well as on any searchable file 
contents. For example, you can search for all files that belong to a certain 
author, for all the locked files, or for any file with a particular string in the title 
field. For more information about doing searches, see Chapter 5, “Search.” 

Modifying a file’s properties

You can change some properties for a file or folder. You can assign yourself as 
owner of a file or folder that has no owner or you can reassign ownership for 
files and folders that you own, you can lock an unlocked file or you can unlock 
files that you have locked, and you can make the file’s contents searchable or 
unsearchable. You can enter new values for title, author, and description, and 
Web Publisher will use your new values instead of those defined in the file.
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To modify these fields, follow these steps:

1. Type in your new data and click any checkbox option you want to change.

2. Click Modify to change the existing property value, or click Reset to revert 
to the original value.

This function reindexes the selected file, updating the searchable properties 
(and file contents if that option is chosen). 

Version History
Netscape Web Publisher provides a version control system for keeping track of 
files as they are updated and changed. You can manually place a file under 
version control by using the Start Version Control menu command or you can 
set automatic version control for a file when you edit or upload a file by 
clicking the Start Version Control checkbox. Regardless of how it was placed 
under version control, the first version is always version 1.1. Each subsequent 
time you edit and then publish the file, the version number increases by 0.1 
increments. See also the section “Starting version control” for more information.

Once a file is under version control, Web Publisher maintains a record of each 
version of a file and gives you access to its versions in these ways:

• You can view a file’s version history

• You can compare two versions for differences

• You can view earlier versions

Note This information is only available for files, not for folders. When you view a 
folder in the Web Publisher Services page, the Version History link is not 
displayed.

To view a file’s version history, do the following:

1. Access the Web Publisher Services page through one of the methods 
described in “Web Publisher Services page.”

2. Click the Version History link in the left frame. The version history for a file 
under version control is displayed in the right frame.
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Figure 4.3  The version history for a file 

The history consists of a series of version information sections, one per version. 
Each section has this information:

• Version—The version number. This was initialized to 1.1 when the original 
file was placed under version control and incremented by 0.1 each time the 
file completed an edit-and-publish cycle. This field is a link to the actual 
version itself, and you click this to view the version.

• Modified By—The user ID of the person who was the last person to edit-
and-publish the file or who set up version control for this file, whichever is 
more recent. 

• Last Modified—The date of the latest file modification, which is the creation 
date for new files. 

• Comments—The text entered when the latest version was created. For files 
that are placed under version control as part of an edit or upload operation, 
this comment initially contains text generated by Web Publisher. When you 
later modify the file, creating additional versions, whatever text you input 
describing your changes is placed in the comments field.

If a file is not under version control, you can start version control for it by 
clicking the Start Version Control button, as shown in Figure 4.4.
Chapter 4, Services and menus 49



Web Publisher Services page
Figure 4.4  Starting version control for a file 

Comparing versions

Web Publisher allows you to compare different versions of a file. The output is 
an HTML file displayed in your web browser window that highlights where the 
versions differ. If you compare different version of a non-HTML file for which 
there is an HTML conversion filter, Web Publisher converts the files into HTML 
and displays their differences as an HTML file in the Browser. See the section 
“About collection attributes” in Chapter 5, “Search,” for a list of filters.

Depending on which version you choose from each drop-down list, you get 
different results from the comparison. The version you choose from the first list 
is taken as the basis for the comparison. The version from the second list is 
examined for differences, either additive or subtractive. Additional text appears 
in green with a green marker on the left. Deleted text is shown as red 
strikethrough text with a red marker on the left. Note that if you compare 
versions of a file that are extremely divergent in size and content, you may not 
be able to easily determine where the two files differ. 

Primarily intended to compare text-based HTML and ASCII files, Web Publisher 
cannot readily compare text files with binary data or files with graphic images. 
If you compare files that differ in which graphics they use or where the 
graphics are positioned in the file, Web Publisher marks the difference with a 
green or red marker as a placeholder rather than displaying the graphic itself.

Note You cannot compare two versions of a file that are in different formats. For 
example, if you have an HTML file under version control and you upload a 
Word-formatted file as the second version, you cannot compare the two 
versions.

To compare versions:

1. Follow the steps in “Version History” for viewing the file‘s version history.
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2. At the top of the right frame, there is a section for comparing versions. See 
Figure 4.3 for a screen shot of this function.

3. From the two drop-down lists, select the two versions you want to 
compare.

4. Click Compare to display an HTML difference file.

Viewing older versions

Web Publisher keeps earlier versions of version controlled files in an archive. 
You can view an older version of a file by following these steps:

1. Follow the steps in “Version History” for viewing the file‘s version history.

2. Click the link in the version number field, labeled “Version,” to view the 
version. For example, click the link v1.3 to see the third version of a file.

The results are shown in a web browser window.

Check Links
Netscape Web Publisher maintains links between files when you copy, move, 
or rename files and directories. You can check links for a file or for a folder. 
This function displays the link status information as of the last time the links 
were checked. To be sure you are up to date, click Check Links. For a file, this 
information provides a list of all outgoing links. For a folder, it provides a 
summary for all the files in the folder, showing which files have at least one 
broken outgoing link. 

See Chapter 8, “Managing links” for more information about how to check links 
in a file or folder.

Custom Properties

Your server administrator can create additional custom properties for the web 
publishing collection. Once new custom properties have been created, 
whenever a file that is part of the web publishing collection is indexed, these 
properties are included. Such properties are user-modifiable and Web Publisher 
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uses any values you input instead of the original value in the file once you 
make changes. The indexing process makes these custom properties available 
to you for viewing and searching. 

Figure 4.5  Custom properties 

Note If a file has not been indexed since the adding of the custom property, the 
property is not viewable. Custom properties are not available until a file has 
been reindexed. 

To view the custom properties for a file, do the following:

1. Access the Web Publisher Services page through one of the methods 
described in “Web Publisher Services page.”

2. Click the Custom Properties link. This displays a list of the custom 
properties that were defined by the server administrator at the time this file 
was last indexed. 

Web Publisher button
This button is useful for users of Netscape Communicator who have accessed 
the Web Publisher Services page through the page services item on the 
Communicator’s View menu. When you click this button, a new Web Publisher 
applet is launched. (For Navigator 3 users, this button is disabled.)
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Agents button

When you click this button, the Netscape Agent Services page is displayed. See 
Chapter 6, “Agents” for more information about agents.

Access Control button

When you click this button, the access control page is displayed. See Chapter 7, 
“Access control” for more information about access control.

Search button

When you click this button, the Netscape Search page is displayed. See 
Chapter 5, “Search” for more information about performing searches.

Help button
When you click this button, the online help file containing information for this 
screen is displayed. This help file also contains information about the menu 
commands in Web Publisher.

The File menu
The File menu provides menu commands that allow you to manage server 
folders, edit and publish files, and upload and download files and folders. 

Creating a new folder

The Web Publisher allows you to create new folder on the server. Because this 
writes a new file to the server, you must have write permission in order to do 
this. Web Publisher prompts you for your password to authorize the operation. 

To create a new folder on the server file system:
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1. Select the existing folder that is to contain the new folder. You can choose 
the primary document directory, or root.

2. From the File menu, choose New Folder or click the New Folder toolbar 
button. The Create New Folder dialog box appears with your folder 
displayed in the Make Folder In field. If you chose to make the folder at the 
root directory, the field is left blank.

3. Type the name for your new folder in the New Folder’s Name field. Do not 
begin with a "/" or use spaces or apostrophes in the name.

4. Click Create to create the folder, or click Cancel to close the window and 
leave the server files untouched.

You cannot create a new folder with the same name as a folder that already 
exists in that directory on your server. If you try, you get an error message and 
the operations fails.

Opening an existing folder

The Web Publisher allows you to open an existing folder on the server, which 
implicitly reloads the current server data for this folder.

To open a folder on the server file system:

1. Select the existing folder to open. 

2. From the File menu, choose Open Folder or click the Open Folder toolbar 
button. 

The folder is displayed in the Web Publisher window as open, with its files and 
subfolders visible.

Browsing a file

You can browse many types of server files in your web browser. HTML files are 
displayed as is. PDF, email, and news files are displayed as plain text in your 
browser. Files in other format, such Microsoft Word and Excel can be viewed in 
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their original format if you have a helper application defined for your browser. 
If you don’t, the web browser prompts you to identify which application should 
be used. 

To view the contents of a file on the server:

1. Select the file.

2. From the File menu, choose Open File in Browser or click the Browse 
toolbar button.

The file is displayed in a web browser window. 

Editing a file
You can edit unlocked files, or files that you locked, if you have write access 
permission for the files. Web Publisher puts the file into an “edit state,” locking 
out other users so that they cannot edit your file until you have published it 
back to the server. 

Depending on what your editor preferences are (Communicator users) or how 
your editor.txt  file is set up (Navigator 3 users), this command launches 
Netscape Navigator’s HTML editor, Netscape Composer, Adobe Acrobat, 
Microsoft Word or Excel, a simple text editor, or some other application that 
you have associated with this particular file’s format. If you do not define an 
editor program for a given file type, Web Publisher displays an Editor 
Launching Error when you open the file for editing. 

Note For Navigator 3 users: If you click Cancel in the first dialog box to appear 
requesting local file access, the edit is canceled and the server file remains 
unchanged. If you click Cancel in later dialog boxes, Web Publisher marks the 
file as being “in edit” whether or not the editor program starts up, and you must 
publish the file before it is available again to other users.

To edit a file in Web Publisher:

1. In the Web Publisher window, select the file you want to edit.

2. From the File menu, choose Open File in Editor to launch the file’s editor 
application and begin editing the file.
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3. When you finish modifying the file, save it in the application and return to 
the Web Publisher window.

Note For Navigator 3 users: If you are using Netscape Navigator’s HTML editor, use 
the Save command. Do not use its Publish command. If you use the Publish 
command, when you return to Web Publisher, you must reload the latest server 
data by using the View | Reload Window menu command. 

To edit a file in Netscape Composer:

1. From Netscape Navigator’s File menu, use the Open File command to select 
the server file for editing in Composer by entering the file’s URL. This 
causes Web Publisher to lock the file so other users cannot edit it simulta-
neously.

2. In Composer, edit the file as usual.

3. When you finish modifying the file, use the Composer’s Publish command 
to put it back on the server.

Canceling an edit

You can cancel an edit operation before you save your changes in the editor 
application, while the file is still in an “in edit” state, so that your file is 
unlocked and remains unchanged on the server. 

To cancel an edit:

1. From the File menu, choose Cancel Editing File.

2. The Cancel File Edit dialog box appears. Click Yes to confirm that you want 
to cancel the edit.

Note For Navigator 3 users: If you click Cancel in the first local file access dialog box, 
you cancel the edit and leave the server file unchanged. Clicking Cancel in later 
dialog boxes does not cancel the edit, requiring you to publish the file before it 
is available again to other users.
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Publishing edited files

An edited file is not available for others to modify until it has been published 
back to the server. Until it is published, it is in an edit state, which locks out 
other users. The properties and content of new HTML files are automatically 
indexed during the publishing operation, making them available for searching. 
This happens also for non-HTML files that have an HTML conversion filter. If 
you are publishing a new version of an existing file, the publishing operation 
reindexes the file’s properties (and contents, if that option is selected on the 
Properties page). 

Note If a file was manually locked before you edited it, publishing the file releases 
the manual lock as well as the implicit editing lock.

Publishing an edited file 

When you finish editing a file and save it, the new version is still not available 
on the server for other users until you publish it. You can only publish your 
own edited files. When you publish a file that does not have an owner, you are 
assigned as the file’s owner. 

To publish an edited file to the server:

1. In the Web Publisher window, select the edited file.

2. From the File menu, choose Publish An Edited File, or click the Publish 
toolbar button. The Publish File dialog box appears with your file’s name in 
the Publish File field.

Figure 4.6  Publish an Edited File dialog box 
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3. To add your own comments to a version-controlled file, you can enter text 
in the Comment field. Your comment is displayed in the file’s version 
history. If a file is not under version control, you cannot add a comment. 
Instead the message “(N/A for files without version control)” appears in this 
field.

4. Click Publish to publish the file.

The edited file is again available on the server, with Web Publisher adding a 
new version for any file under version control.

Note If you are using Netscape Composer, when you complete your changes, use 
the Composer’s Publish command to restore it to the server. This causes Web 
Publisher to unlock the implicit edit lock on the file. 

Publishing all edited files

When you finish editing a file and save it, the new version is still not available 
on the server for other users until you publish it. If you have edited more than 
one file for a given server, you can publish them all simultaneously rather than 
publish each file separately. If you have only edited one file, this function is 
disabled.

When you publish a file that does not have an owner, you are assigned as the 
file’s owner.

To publish all edited files to the server:

1. From the File menu, choose Publish All Edited Files. The Publish All Edited 
Files dialog box appears with a list of all files in the “edit” state.

Figure 4.7  List of edited files 
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2. To add your own comments, you can enter text in the Comment field. Your 
comment is displayed in the version history for files under version control. 
It is ignored for files without version control.

3. Click Publish to publish the files.

The edited files are again available on the server, with Web Publisher adding a 
new version for any file under version control.

Uploading to your server
You can put a file or folder from your local system onto the server, making it 
available for other users. Whether a file is an application, a word processing 
document, a PDF file, a spreadsheet, or HTML file—you can upload it to the 
server with Web Publisher. 

The properties and content of new HTML files are automatically indexed during 
the upload, making them available for searching. This happens also for non-
HTML files that have an HTML conversion filter. If you are uploading a new 
version of an existing file, uploading reindexes the file’s properties (and 
contents, if that option is selected on the Properties page). 

You can add a file or folder to an existing folder, replace an existing file if the 
server file does not have version control, or add a new version for server files 
under version control. You can set the new file to be under version control and 
locked or unlocked. When uploading a folder to the server, you can also 
upload its subfolders. 

Note For Navigator 3 users: You can only upload individual files, not folders.

You can establish a default upload directory on your local system that becomes 
the location where Web Publisher expects your local files to be found. To do 
this, you define a local directory for uploading and downloading as described 
in “User preferences.” 

There some special cases to consider when you are uploading a file from your 
local system to the server:

1. The existing server file is overwritten

• if a file already exists with the same name in that directory and
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• it is not under version control.

2. The file you are uploading becomes a new version of the existing server file

• if a file already exists with the same name in that directory and 

• it is under version control and

• you are the owner.

3. The upload fails

• if a file already exists with the same name in that directory and 

• it is under version control and

• you are not the owner.

To upload a file:

1. In the Web Publisher window, select the file that you want to replace or 
update or select the folder that is to contain the new file.

2. From the File menu, choose Upload to Server. The Upload File or Folder 
dialog box appears.

Figure 4.8  Upload dialog box 

3. In the Upload Local File or Folder field, type the full pathname of your local 
file. If you have defined a default upload folder, the folder’s name is already 
displayed. The Browse button is disabled for Navigator 3 users.

4. Your destination folder’s pathname appears in the To Server File or Folder 
field. You can also change the destination that appears. 
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5. You can optionally start version control for this file, by checking the “Start 
version control on uploaded files” option. The default is to start version 
control. 

6. You can lock a file when you put it on the server by checking the “Lock 
files after upload” option. The default is not to lock files.

7. Click Upload to add your local file to the server. 

8. A dialog box is displayed asking you to update the file properties for this 
file. Click OK to go to the Web Publisher Services page with the Properties 
for this file.

To upload a folder (for Communicator users only):

1. In the Web Publisher window, select the folder that you want to replace or 
update or that is to contain the newly uploaded folder.

2. From the File menu, choose Upload to Server. The Upload File or Folder 
dialog box appears.

3. In the Upload Local File or Folder field, type the full pathname of your local 
folder. If you have defined a default upload folder, the folder’s name is 
already displayed. An alternative is to click the Browse button to find it on 
your local system.

4. To upload your folder’s subfolders, check the Include Subfolders checkbox. 
The default is not to upload subfolders.

If you upload a folder and files with the same names as those already 
existing on the server, Web Publisher handles each file within the folder on 
an individual basis. Files with version control are incremented with a new 
version and files without version control are overwritten.

5. Your destination folder’s pathname appears in the To Server File or Folder 
field. You can also change the destination that appears. 

6. You can optionally start version control for files within this folder by 
checking the “Start version control on uploaded files” option. The default is 
to start version control. 

7. You can lock the folder’s files when you put them on the server by 
checking the “Lock files after upload” option. The default is not to lock files.
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8. Click Upload to add your local folder to the server. A dialog box is 
displayed giving you a summary of the completion status for the uploaded 
folders and files.

9. A dialog box is displayed asking you to update the properties for this 
folder. Click OK to go to the Web Publisher Services page with the 
Properties for this folder.

Downloading from the server
You can download a file or a folder from the server to your local system. You 
can choose to also download the subfolders within the folder you want to 
download and you can choose to lock the server files that you are 
downloading. 

You can establish a default download directory on your local system that 
becomes the location where Web Publisher places your downloaded files. To 
do this, you set a user preference as described in “User preferences.” 

• When you download a file or folder with the Lock Server Files option set, 
the server files are locked so that other users can no longer edit the original 
server file. 

• You cannot download locked or edited files as Lock for Editing unless you 
are the owner of the file. 

To download a file or folder

1. In the Web Publisher window, select the file or folder you want to 
download.

2. From the File menu, choose Download From Server. 

For files, the Download File dialog box appears with the name of the 
selected file in the Download Server File field. 
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Figure 4.9  Download file dialog box 

For folders, the Download Folder dialog box appears with the name of the 
selected folder in the Download Server Folder field. 

Figure 4.10  Download dialog box 

3. For folders, you can check the Include Subfolders option to also download 
any subfolders within the selected folder.

4. Type the download destination in the To Local File (for files) or To Local 
Folder (for folders) field. If you have defined a default download folder, the 
folder’s name is already displayed. For files, you can type in a different 
filename to rename the file as part of the download operation. 

5. You can place a lock on the server files you are downloading by choosing 
the Lock Server Files option. The default is not to lock files.

6. Click Download to download a server file or folder to your local system. 
For folders, a dialog box is displayed giving you a summary of the 
completion status for the downloaded folders and files.

Note You can also “download” a file from the server to your local drive by opening 
the file in a web browser and using the Save As menu command from the 
Navigator’s File menu. Saving a file in this manner is not recommended because 
it skips the automatic link management and indexing functions that are 
provided by Web Publisher. Files saved in this way require manual intervention 
to update their links and to index their contents and properties. 
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Exiting from Web Publisher

You can exit from Web Publisher at any time. To relaunch Web Publisher, you 
must return to the Web Publisher home page. See the section “The Web 
Publisher home page” in Chapter 2, “Installing and configuring” for information 
about the home page. 

The Edit menu
The Edit menu provides menu commands that allow you to lock and unlock 
files; copy, move, rename, and delete files and folders; and set user 
preferences. 

Locking and unlocking a file
Once you have locked a file, other users cannot move, rename, delete, or edit it 
until you unlock it. You can manually lock a file when you do not want other 
users to have access to it. You can also direct Web Publisher to lock files that 
you are downloading. 

You can unlock any file that you locked or any file that you downloaded with 
the Lock Server Files option checked. You cannot lock a folder.

Note You can unlock a file that is being edited by another user, but you are strongly 
recommended not to do this. If you do, Web Publisher continues to list the file 
as a file that needs to be published even though the pen icon is removed from 
the Web Publisher window. 

Locking a file

You can lock any file, including those owned by another user. If you lock a 
file, the file is displayed in the Web Publisher Services page with you as the 
lock owner and only you can unlock it.

To manually lock a file: 

1. In the Web Publisher window, select the file you want to lock.
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2. From the Edit menu, choose Lock. If you did not set a user preference to 
confirm locking operations, the file is locked at this point.

3. If you have set the user preference to request lock confirmations, the Lock 
File dialog box appears with your file’s name in the Lock File field.

4. Click the Lock button to lock the file.

Note Communicator users with the Composer plug-in can also manually lock a 
server file from the Composer application on their local system by using the 
Tools | Web Publisher | Lock menu command.

Unlocking a file

If you locked a file, you can unlock it. The server administrator is also 
authorized to unlock a file that you have locked. 

To unlock a file:

1. In the Web Publisher window, select the file you want to unlock.

2. From the Edit menu, choose Unlock. If you did not set a user preference to 
confirm unlocking operations, the file is unlocked at this point.

3. If you have set the user preference to request unlock confirmations, the 
Unlock File dialog box appears with your file’s name in the Unlock File 
field.

4. Click the Lock button to unlock the file.

Note Communicator users with the Composer plug-in can also manually unlock a 
server file from the Composer application on their local system by using the 
Tools | Web Publisher | Unlock menu command.

Copying files and folders
You can copy locked and unlocked files and folders. You need read and write 
permission for all the files and folders within a folder in order to be permitted 
to copy the folder. When you copy a file that is under version control, or a 
folder containgin version controlled files, only the most recent version of each 
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file is copied to the new location. The previous versions of the file are not 
copied. You must select the original file to view previous versions of the file 
and its version history. 

You are assigned as the owner of the new folders and files, and the new files 
are not placed under version control. If Automatic Link Update is turned on for 
your server, outgoing links in a newly copied file are mapped to point to the 
same target folders as the links in the original file.

Copying a file

When you copy a file, you become the owner of the copied version of the file. 
You can copy locked and unlocked files. 

To copy a file:

1. Select the file in the Web Publisher window.

2. From the Edit menu, choose Copy to (or use the Control key + drag-and-
drop method to copy the file into a new location). The Copy File or Folder 
dialog box appears with the name of the selected file in the Copy File or 
Folder field. 

Figure 4.11  Copy dialog box 

3. Enter the filename for the new copy in the To File or Folder field (if you 
used the drag-and-drop method the file in step 2, this field is already filled 
in).

Note: Do not begin with a “/” if you want to copy the file to the primary 
Web Publisher document directory. 

4. Click Copy to copy the file.
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Copying a folder

When you copy a folder, all the files and folders within it are copied and you 
become the owner of the new files and folders. 

To copy a folder:

1. Select the folder in the Web Publisher window.

2. From the Edit menu, choose Copy to (or use the Control key + drag-and-
drop method to copy the folder in a new location). The Copy File dialog 
box appears with the name of the selected folder in the Copy file field. 

3. Enter the path for the new copy of the folder in the To file field (if you used 
the drag-and-drop method the file in step 2, this field is already filled in).

4. Click Copy to copy the folder and its files.

Moving files and folders

You can move unlocked server files and folders. Web Publisher automatically 
updates all the links within and to the moved documents. Moving requests are 
subject to access control restrictions for the specified folder or file that you wish 
to move. If you want to prevent other users from moving your folders and files, 
you can use the access control function to limit the Delete access right to 
yourself. See Chapter 7, “Access control,” for more information about access 
control. 

If Automatic Link Update is turned on for your server, outgoing links in newly 
moved files, including those in a moved folder, are mapped to point back to 
their original target folders. Incoming links from other server files are mapped 
to point to the newly moved files and folders.

Moving a file

You can move an unlocked file if you have delete privileges for the file. You 
cannot move a locked or unpublished file. When you move a file that has no 
owner, you are assigned as the owner of the file. If the file already has an 
owner, the ownership is not changed.

To move a file:
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1. Select the file in the Web Publisher window.

2. From the Edit menu, choose the Move to command (or use the drag-and-
drop method to drag the file to its new location). The Move File or Folder 
dialog box appears with the name of the selected file in the Move File or 
Folder field. 

Figure 4.12  Move dialog box 

3. Enter the name of the folder that is to contain the moved file in the Within 
Folder field (if you used the drag-and-drop method the file in step 2, this 
field is already filled in). Do not type in a filename.

Note: Do not begin a with a “/” if you want to copy the file to the primary 
Web Publisher document directory. You must use a “/” at the end of a 
folder’s pathname.

4. Click Move to move the file.

Moving a folder

You can move a folder if you have read-write privileges for the folder and all 
the files within it. You cannot move a folder if there is any locked or unpub-
lished file within the folder. When you move a folder and files that are not yet 
assigned any owner, you are assigned as the owner of the folder and its files. If 
the folder and files already have an owner, the ownership is not changed.

To move a folder:

1. Select the folder in the Web Publisher window.

2. From the Edit menu, choose Move to command (or use the drag-and-drop 
method to drag the file to its new location). The Move File dialog box 
appears with the name of the selected folder in the Move file field. 
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3. Enter the new path for the folder in the To dir field (if you used the drag-
and-drop method the file in step 2, this field is already filled in).

Note: Do not begin with a “/” if you want to copy the folder to the primary 
Web Publisher document directory. You must use a “/” at the end of the 
folder’s pathname.

4. Click Move to move the folder and its files.

Renaming files and folders
You can rename unlocked server files and folders. Web Publisher automatically 
updates all the links within and to the renamed documents. Renaming requests 
are subject to access control restrictions for the specified folder or file that you 
wish to rename. If you want to prevent other users from renaming your folders 
and files, you can use the access control function to limit the Delete access right 
to yourself. See Chapter 7, “Access control,” for more information about access 
control. 

If Automatic Link Update is turned on for your server, outgoing links in newly 
renamed files, including those in a moved folder, are mapped to point back to 
their original target folders. Incoming links from other server files are mapped 
to point to the newly renamed files and folders.

Renaming a file

You can rename an unlocked file within a folder if you have read-write privi-
leges for the file. You cannot rename locked or unpublished files. When you 
move a file that has no owner, you are assigned as the owner of the file. If the 
file already has an owner, the ownership is not changed.

If you rename a version controlled file, the file’s version archive is still acces-
sible through the new name. You can no longer access earlier versions through 
the previous filename.

To rename a file:

1. Select the file in the Web Publisher window.

2. From the Edit menu, choose Rename. The Rename File dialog box appears 
with the name of the selected file in the Rename file field.
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Figure 4.13  Rename dialog box 

3. Enter the new name for the file in the To Name field. Do not type in the 
file’s path. That is, type newIndex.html , not /docs/newIndex.html .

4. Click Rename to rename the file.

Renaming a folder

You can rename a folder if you have read-write privileges for the folder and all 
the files within it. You cannot rename a folder if there is any locked or unpub-
lished file within the folder.When you rename a folder and files that are not yet 
assigned any owner, you are assigned as the owner of the folder and its files. If 
the folder and files already have an owner, the ownership is not changed. 

To rename a folder:

1. From the Edit menu, choose Rename. The Rename File dialog box appears 
with the name of the selected folder in the Rename file field.

2. Enter the new folder name for the folder in the To Name field. Do not type 
in any additional pathname information. That is, type Project-X , rather 
than /docs/Project-X .

3. Click Rename to rename the folder.

Deleting files and folders

You can delete unlocked files and folders on the server. Once you delete a file, 
it is no longer searchable. Delete requests are subject to access control restric-
tions for the specified folder or file that you wish to delete. If you want to 
prevent other users from deleting your folders and files, you can use the access 
control function to limit the Delete access right to yourself. See Chapter 7, 
“Access control,” for more information about access control.
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You can set a user preference to request confirmation of delete operations. This 
is the default and is the recommended method. See “User preferences” for more 
information.

Deleting a file

You can delete an unlocked file if you have delete permission for the file. You 
cannot delete locked or unpublished files. Once you delete a file, you can no 
longer search on its properties or contents. 

To delete a file:

1. Select the file in the Web Publisher window.

2. From the Edit menu, choose Delete or press the Delete key. If you did not 
set a user preference to confirm deletions, the file is deleted at this point.

3. If you have set the user preference to request delete confirmations, the 
Delete File or Folder dialog box appears with your file’s name in the Delete 
File or Folder field.

Figure 4.14  Delete confirmation dialog box 

4. Click Delete to delete the file or Cancel to close the window and leave the 
server file untouched. 

Your server administrator can restore deleted files that are under version 
control. The most recently published version of the file is the version that is 
restored. 

Deleting a folder

You can delete a folder if you have delete permission for the folder and for 
every file within the folder. You cannot delete a folder if there is any locked or 
unpublished file within the folder.

To delete a folder:
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1. Select the folder in the Web Publisher window.

2. From the Edit menu, choose Delete or press the Delete key. If you did not 
set a user preference to confirm deletions, the folder is deleted at this point.

3. If you have set the user preference to request delete confirmations, the 
Delete File or Folder dialog box appears with your folder’s name in the 
Delete File or Folder field. 

4. Click Delete to delete the folder or Cancel to close the window and leave 
the server folders untouched. 

Note Your server administrator cannot restore deleted folders. However, when you 
restore a file that was inside a folder that has also been deleted, Web Publisher 
recreates the same folder structure for your file as you had before you deleted 
it. This may mean that one or more folders must be created to replicate the 
path structure. These folders will have the same names as the deleted folders, 
but will be empty. 

User preferences
You can set several preferences for Web Publisher: user name, operations to 
confirm, display font, and which local folders to use for uploading, 
downloading, and storing “in edit” files. These are stored in the 
nswppref.txt  file in your Navigator’s WebPub folder along with some other 
settings that Web Publisher sets for you internally. Communicator users can 
also set their editor preferences from this menu. See the section, “The Web 
Publisher preferences file,” for more information about this file.

User name preference

The User Name Preference dialog box lets you enter a new user name for Web 
Publisher. Many Web Publisher operations depend on the user’s name to 
identify the owner or lock owner for a file. 

You can check a checkbox that allows you to set this name as the default 
name, which means that Web Publisher does not require you to input your user 
name each time you launch Web Publisher. If you want to be prompted for a 
user name whenever you start up Web Publisher, do not check the default 
name checkbox. 
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If you leave the user name field blank, you are prompted for user name and 
password rather than just the password when you execute an operation that 
requires authorization. 

You must use a username that is valid for your server. See your server adminis-
trator for more information, if necessary. Actions that require a authorization 
include editing, uploading, copying, moving, and renaming files as well starting 
version control for a file and creating a new folder on the server. 

Figure 4.15  The user name preference dialog box 

Operations to confirm

The Operations to Confirm dialog box lets you to direct Web Publisher to ask 
for confirmation whenever you use the drag-and-drop method to copy or move 
files or folders, or whenever you delete, lock, or unlock files or folders. Without 
these options checked, Web Publisher immediately performs the action without 
giving you a second chance to revisit your decision.

Figure 4.16  The confirm operations dialog box 

Directories

The Local Folder Preferences dialog box allows you to set two types of folder 
preferences: for uploading or downloading files and for storing “in edit” files. 

You can set a preference for which local folder is to serve as the source folder 
for upload operations and as the destination location for downloads. You needs 
to enter the full physical path, For example, C:\Projects\TempDir . 
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You can also set a preference for which local folder to use for files during 
editing, that is, as the temporary storage folder for files in an “in edit” state. 
Unless you are using Netscape Composer to edit your HTML files and you have 
set your editor preference to edit directly on the server, files being edited are 
temporarily copied to your local system. Once you publish the file, the 
temporary “in edit” file is deleted from your local system.

You cannot change your local folder preferences while a file is still in an edit 
state. You must publish all edited files before you can change a directory 
preference.

Note For Windows systems that require 8.3 file notation, you must use pathnames 
with this notation for your directory preferences. Because it occurs so 
frequently, Web Publisher handles one case for you automatically: If the folder 
you want to use for files during editing has Program Files  as part of its 
pathname, Web Publisher translates it to Progra~1  for you.

Figure 4.17  The local folder preferences dialog box 

Font

The Font Chooser dialog box lets you define the font, font size, and font style 
to display in the window. Fonts in other windows and dialog boxes are not 
modifiable. 

To close this dialog box, you must click the button in the top left corner. 
Clicking the Set button does not make the dialog box disappear. 

Figure 4.18  The font chooser dialog box 
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Editors

This option is available for Netscape Communicator users only.

The Editor Preferences dialog box lists the defined editor applications that have 
been associated with specific file types. The default is to list the Composer 
component of Netscape Communicator as the HTML editor of choice.

Figure 4.19  The editor preferences 

If you want to associate another editor program with a specific file type, you 
can use the Set Editor Program dialog box to enter the file extension for the file 
and indicate the executable program file.

Figure 4.20  The set editor program preferences dialog box
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The View menu
The View menu provides several commands for viewing or redisplaying Web 
Publisher data. The first command, Properties, displays the Web Publisher 
Services page, which is the main page for viewing data about your files and 
folders. From this page, you can look at the version history for a file, check 
links, and view any custom properties that have been defined 

The other View menu commands let you to change the sort sequence for the 
contents of the window, to reload and refresh the window data, and to show or 
hide the Web Publisher toolbar.

Properties

To view a file’s properties through the Web Publisher Services page, do the 
following:

1. Select the file.

2. From the View menu, choose Properties or click the Information toolbar 
button. The Web Publisher Services window appears. See “Properties” for 
more information.

Sorting files and folders

You can choose to sort the files and folders in various different sort sequences. 
There are two ways to do this:

• From the View menu, choose Sort By and choose the appropriate sort 
sequence from the submenu (Name, Date, or Size). 

• Alternatively, you can click the heading above the name, date, or size 
columns to resort the files and folders displayed in the window.
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Redrawing the window

You can choose to redraw the Web Publisher window to resolve display 
problems you may have with the current image of the window.

To redraw the window, do this:

1. From the View menu, choose Redraw Window.

Reloading the window
You can reload the Web Publisher window to ensure that the window displays 
the latest set of files and their current status from the server. This ensures that 
you have all the current file management changes. In particular, this is useful to 
update the displayed owner and lock status of a file.

To reload the window, do this:

1. From the View menu, choose Reload Window.

Showing the toolbar
You can toggle the toolbar on and off: 

• To show the toolbar, from the View menu, choose Show Toolbar

• To hide the toolbar, from the View menu, choose Hide Toolbar.

The Services menu
This chapter describes the simpler commands on this menu, such as those for 
link management and for starting or stopping version control. The functional 
areas of text search, agent services, access permissions, and link management 
are described in separate chapters. 
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For text search, see Chapter 5, “Search.” For agent services, see Chapter 6, 
“Agents.” For access permissions, see Chapter 7, “Access control.” For link 
management, see Chapter 8, “Managing links.” 

Starting version control

You can establish version control for any Web Publisher file. Once you do so, 
Web Publisher tracks any change made to the file’s contents or properties. 
Version control can be started automatically, as when you upload a local file to 
the server with the Start Version Control option checked, or you can start it 
manually. When you start version control for a file that does not yet have an 
owner, you are assigned as its owner. If the file already has an owner, the 
ownership is not changed.

Regardless of how it was placed under version control, the first version is 
always version 1.1. Each subsequent time you edit and then publish the file, the 
version number increases by 0.1 increments.

Note When you copy a file under version control, the newly copied file is not placed 
under version control. If you want version control for the file, you need to 
manually start version control for it.

There are two ways to manually start version control for a file. One method is 
as follows:

1. Select a file that is not currently under version control.

2. From the Services menu, choose the Start Version Control command.

Alternatively, you can use the second method:

1. Select a file that is not currently under version control.

2. From the Services menu, choose the Properties command, or click the 
Information toolbar button. This displays the Web Publisher Services page.

3. Click the Version History link. This displays a message, “Version Control has 
not been started for this file.”
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Figure 4.21  Version control not yet started 

4. Click Start Version Control to set version control on for this file.

The file now has a stack icon next to it in the Web Publisher window. When 
you view the file’s version history, you can see that the file now has a 1.1 
version number.

Stopping version control
You can stop version control for any file under version control. If you stop 
version control, the version history archive does not delete the previous history 
for this file, but you can’t view it. If you later start version control again, Web 
Publisher adds the current server file to the version history archive as the latest 
version, incrementing the version number by 0.1 from the version number you 
had when you stopped version control. 

For example, if you stopped a file at version 1.7 and made three edits without 
version control, when you started version control again for the file, Web 
Publisher puts the current server file into the archive as version 1.8. You can 
only track the last modification made to the server file. Earlier edits are 
unobtainable as separate versions.

To stop version control for a file, follow these steps:

1. Select a version controlled file.

2. From the Services menu, choose the Stop Version Control command.
Chapter 4, Services and menus 79



The Help menu
The Help menu
The Help menu has two items to provide assistance for Web Publisher and to 
provide some basic product information. 

Web Publisher Help

You can access the Web Publisher User’s Guide to get additional information 
about how to install the product, to find out more details about the Web 
Publisher functions and services, and to learn about using text search, agent 
services, access control, and link management. 

To access the User’s Guide, do the following:

1. From the Help menu, choose the Web Publisher Help command. 

2. This opens up a new web browser with the table of contents. You can 
navigate the User’s Guide files by clicking on the topics you are interested 
in and then going back and forward as usual.

About

You can access some basic information about Web Publisher, including the 
product’s current version number, by viewing the About box for the product.

To access the About box, do the following:

1. From the Help menu, choose the About command.
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5
Search
Overview
The Netscape Web Publisher search function provides you with the ability to 
search the file information and contents of documents on a remote server. 
Server documents can be in a variety of formats, such as HTML, Microsoft 
Word, Adobe PDF, and WordPerfect. The server converts many types of non-
HTML documents into HTML as it indexes them so that you can use your web 
browser to view the documents that are found for your search. 

You can search through server documents for a specific word or attribute 
value, obtaining a set of search results that list all documents that match the 
query. You can then select a document from the list to browse it in its entirety. 
This provides easy access to server content.

There are four parts to text searching:

• making a query—you enter your search criteria.

• displaying search results—the server displays a list of the documents that 
match your criteria.

• viewing a document—you can view a specific highlighted document from 
the search results list.

• viewing the contents of a document information collection—you can look 
at the information that is maintained for each of your collections. 
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Search home
page

There is a search home page, at http://search-ui/examples , that 
provides individual links to the search query interfaces, samples of search input 
and output, and a brief tutorial on how your server administrator can customize 
the interface. 

Preparing data for searching
To enable searching capability on your server, the server administrator begins 
by identifying the documents that you want to be able to search. Before you 
can execute searches, you need a database of searchable data against which 
you can target your searches. Your server administrator has to create a 
document information database, called a collection, that indexes and stores the 
content and file properties for each of the documents you want to be able to 
search. 

In the case of Web Publisher, there is a default web publishing collection that 
contains all the documents that you have published, uploaded, or otherwise 
manipulated through Web Publisher. Your server administrator can also do 
bulk indexing of web publishing data for you, for example, by indexing all the 
documents in the document directory defined for Web Publisher.

Collections contain such information as the format of the documents, the 
language they are in, their searchable attributes, the number of documents in 
the collection, the collection’s status, and a brief description of the collection. 
For more details, see the section “Displaying collection contents.”

About collection attributes

Server documents can be in a variety of formats, such as HTML, Microsoft 
Excel, Adobe PDF, and WordPerfect. If there is a conversion filter available for 
a particular file format, the server converts the documents into HTML as it 
indexes them so that you can use your web browser to view the documents 
that are found for your search. 

There are conversion filters for documents in these formats:

• MS Rich Text Format (RTF)

• Interleaf 5.2-6.0
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• MS Word (DOS) 3.0-6.0

• MS Word (Macintosh) 3-6

• MS Word (Windows) 2.0, 6.0, 7.0

• MS Excel 2-5

• MS Excel (Macintosh) 3-4

• MS PowerPoint 7.0

• Adobe PDF (to ASCII)

• Adobe FrameMaker (MIF) 3.0-5.0

• Ami Pro 1.x-3.1

• WordPerfect (Macintosh) 2-3.5

• WordPerfect (Windows) 5.x-6.1

• news and mail file formats (to ASCII)

Note If a PDF file is password-protected or contains special graphical navigation 
icons, the conversion filter cannot index the file.

Certain file formats have a default set of attributes that are indexed for files of 
that type, as shown in Table 5.1. Note that ASCII files have no default attributes. 

Table 5.1 The default attributes indexed for each file format

File format Attribute Type Description

ASCII - - -

HTML Title text The user-defined title of the file.

SourceType text The original format of the document.

NEWS From text The source userID of the news item.

 Subject text The text from the subject field of the news item. 

Keywords text Any keywords defined for the news item

Date date The date the news item was created.

EMAIL From text The source userID of the email.
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META-tagged attributes

By default, HTML collections only have Title  and SourceType  attributes, 
but they can be set up to also permit searching and sorting by up to 30 file 
attributes tagged with the HTML <META> tag. 

For example, a document could have these META-tagged attributes:

<META NAME="Writer" CONTENT="J. S. Smith">
<META NAME="PubDate" CONTENT="07-24-97">
<META NAME="Product" CONTENT="Communicator">

 To text The destination userID of the email.

Subject text The text from the email’s subject field. 

Date date The date the email was created.

PDF InstanceID text An internal ID number.

 PermanentID text An internal ID number.

 NumPages integer The number of pages in the document.

 DirID text The directory where the PDF file exists.

FTS_ModificationDate date The document’s last modification date.

FTS_CreationDate date The document’s creation date.

WXEVersion integer The version of Adobe Word Finder used to extract 
the text from the PDF document.

 FileName text The Adobe filename specification.

 FTS_Title text The document’s title.

 FTS_Subject text The document’s subject.

 FTS_Author text The document’s author.

 FTS_Creator text The document’s creator.

 FTS_Producer text The document’s producer.

FTS_Keywords text The document’s keywords.

PageMap text The page map, describing the word instances for 
the page.

Table 5.1 The default attributes indexed for each file format
84 Netscape Web Publisher User’s Guide



Performing a search: the basics
If this document had been indexed with its META tags extracted, you could 
search it for specific values in the writer, publication date, or product fields. For 
example, you could enter this query: Writer <contains> Smith  or 
PubDate > 1/1/97 .

Note Any attribute values in META-tagged fields are text strings only, which means 
that dates and numbers are sorted as text, not as dates or numbers. Also, illegal 
HTML characters in a META-tagged attribute are replaced with a hyphen.

Performing a search: the basics
Users are primarily concerned with querying the data in the search collections 
and getting a list of documents in return. The default installation of the 
Enterprise server includes a set of search query and result pages to allow users 
a quick and easy way of doing searches.

Creating a search query

There are three default search query pages: standard and advanced HTML 
forms and a Java-based guided applet. 

On the standard search form, you select a collection to search against and type 
in a word or phrase to search for using the query language operators. 

On the advanced HTML form, you have the additional options of selecting 
multiple collections to search through, establishing a sort sequence for the 
results, and defining how many documents are to be displayed on a page at a 
time (clicking the Prev and Next arrows moves you through the pages of 
results). 

In the guided Java-based search applet, the applet uses several drop-down lists 
to guide you through constructing a query. You must have Java enabled for 
your browser to use this applet.

The standard search query form

To perform a standard search, follow these steps:

1. Type this URL in the location field in your web browser:
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http:// yourServer /search

Figure 5.1  The standard search query page 

2. In the search query page that appears, choose the collection you want to 
search through from the drop-down list in the Search In field. 

3. Enter the word or phrase for your search query in the For field. You can 
create complex queries by combining operators. See “Query operators: a 
reference” for details about the search operators.

4. Click the Search button to execute your query.

The advanced HTML search query page

You can choose to use the advanced HTML search form, which helps you 
construct the query. This form is especially useful if you want to search through 
more than one collection or that produces results sorted by a specific attribute 
value.

To access advanced HTML search through the standard search query page, 
follow these steps:

1. Go to the standard search query page by typing this URL in the location 
field in your web browser:

http:// yourServer /search

2. Disable Java for your browser. To do this, use the Languages option 
preferences menu command. 

3. Click Guided Search on the standard search form to display the advanced 
HTML query page.
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Figure 5.2  The advanced HTML search query page 

4. In the For field, type in the word or phrase you want to search for. You can 
create complex queries by combining operators. See “Query operators: a 
reference” for details about the search operators.

5. You can type in one or more attributes to sort the results by. The default is 
an ascending sort order, but you can indicate a descending sort order with a 
minus, as in -Pubdate . (See “Sorting the results” for more information 
about sorting).

6. Depending on how many fields are listed for each document in the search 
results page or how many you want to see at a time, you can expand or 
limit the number of matching documents you want the search to return at a 
time. The Prev and Next buttons allow you access to additional pages of 
documents if there are too many to fit on a page at once.

7. Use the drop-down list in the Search In field to choose the collection you 
want to search through. You can select more than one collection by holding 
down the Control key as you click on another collection. All collections in a 
query must be in the same language.

8. Click the Search button to execute your query.
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The guided search applet

You can choose to use the Java-based guided search interface, which helps you 
construct the query. This is especially useful if you want to build a query that 
has several parts, say searching for a word in the documents’ content as well as 
a specific attribute value.

Note Make sure Java is enabled for your browser. To do this, use the Languages 
option preferences menu command.

To access guided search from the standard search query page, follow these 
steps:

1. Obtain the standard search query page by using this URL:

http:// yourServer /search

2. Click Guided Search on the standard search page to display the guided 
Java-based query page.

Figure 5.3  The guided search query applet 

3. Choose the collection you want to search through from the drop-down list 
in the Search In field.

4. Use the For drop-down list to select the type of element you wish to search 
for. In this example, choose Words.

5. In the blank text field, type in the word you want to search for. See “Query 
operators: a reference” for details about the search operators.
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6. Click Add Line to add the first part of the query. The word appears in the 
large text display box at the bottom of the form.

7. To add to your query, choose another element from the drop-down list. In 
this example, choose Attribute. 

8. A new drop-down list appears on the right side of the form, listing all 
attributes that are available for the chosen collection. Choose the attribute 
you want to search against.

9. From the drop-down list above the text input field, choose a query operator 
(Contains, Starts, Ends, Matches, Has a substring) or logical operator (=, <, 
>, <=, >=) for your query.

10. In the blank text field, type in the attribute value you want to search for.

11. Click Add Line to add another line for your query. You can click Undo Line 
to remove the last line you added or Clear to remove the entire query.

12. Click the Search button to execute the search.

Getting search results

There are two standard types of search results: a list of all documents that 
match the search criteria and the text of a single document that you selected 
from the list of matching documents.

Access permission checking

Which documents you get for your search results depend on the access control 
rules set for each of the documents and collections involved. The server does 
an access check when you perform these actions:

• searching on the Web Publishing collection only, not as part of a multi-
collection search

• searching on any collection other than the Web Publishing collection, singly 
or as part of a multi-collection search

• clicking on the URL for a document listed as part of the search results
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• clicking on the link, which may be a graphical element, that displays the 
document with the search query word or phrase in highlighted text. 

If the server encounters an access control rule that restricts your access to a 
document that matches your query, the document is not listed as part of the 
search results. If you do not have permission to view a document listed in the 
search results, the server does not display it.

Listing matched documents

In the default installation of the Netscape Enterprise Server, when you execute 
a search from either the simple or advanced search query pages, you obtain a 
list of the documents that match your search criteria. The list gives some 
standard information about each file, depending on the collection’s format. For 
example, the default results page for email collections give subject, to, from, 
and date for each entry and news collections give subject, from, and date for 
each entry. 

Figure 5.4  Sample search results 

The kind of file format in the collection indicates which default attributes are 
available for searching. See “About collection attributes” and Table  for 
information about the attributes for each format. 
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For entries resulting from a search that checks for comparative proximity of 
words to each other or for the exactness of the match, the file’s ranking can be 
provided by showing a score. 

If there are more matching documents than can fit on a page, click Next to see 
the next batch. You can always execute a new search by entering new query 
data and clicking Search.

Sorting the results

By default, or if you don’t enter anything in the Sort By field on the advanced 
HTML query page, all documents matching the search are output according to 
their relevance ranking (for queries that consider this) or their position in the 
server file database (for other queries).

If you enter an attribute name in the Sort By field, the documents are displayed 
in an ascending sort sequence. You can list the documents in a descending sort 
sequence by adding a minus sign (-) prefix to the attribute, as in -keywords  
or -title . You can do a multiple sort, by typing in more than one field, as in 
Author,-PubDate . 

In a short query, sort order usually isn’t critical, but in queries that result in a 
great many matches, you may want to set a sort value in order to obtain useful 
search results. Note, however, using a special sort sequence may impact the 
search’s performance. 

Note Attribute values in META-tagged fields are text strings, which means that dates 
and numbers are sorted as text, not as dates or numbers. To convert the value 
into a date or number, you can create a new property in the Web 
Publishing|Add Custom Property form and check the box that marks this 
property as a META-tagged attribute. 

Displaying a document

In the default installation of Netscape Enterprise Server, when you obtain a list 
of the documents that match your search criteria, you can select a single 
document to display in your web browser. The browser can display the original 
document or you can choose to display the document with additional 
formatting so that your search query word or phrase is highlighted with such 
text attributes as color, boldface, or blinking.
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To view the original document, click on the hypertext link containing the 
document’s URL. In the case of documents that have been converted into 
HTML, the URL points you to the original document. Clicking on this link 
spawns an external viewer to display the document in its original format.

To view a highlighted document, click on the graphical element next to the 
document’s entry in the search results. 

Displaying collection contents
You can display the contents of your collection database to see which attributes 
are set for each collection. Your server administrator may have defined some 
collections as non-displayable, in which case they are not inclued in the output. 
The collection contents typically include these items:

• collection name, label, and description

• collection format

• number of attributes in the collection and a list of their names

• number of documents in the collection

• collection size and status

• language and character set

• input and output date formats

To display your collection database contents, type this line in the web 
browser’s URL location field (be sure not to include any spaces):

http:// yourServer /search?NS-search-page=c

Using the query operators
To perform an effective search, you need to know how to use the query 
operators. You can only do Boolean searches, so all the subsequent 
information is based on Boolean search rules. 
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Note The query language is not case-sensitive. The examples use uppercase for 
clarity only.

The search engine interprets the search query based on a set of syntax rules. 
For example, by entering the word region, the actual word region and all its 
stemmed variations (such as regions and regional) are found. The search results 
are ranked for “importance,” which means how close the matched word comes 
to the originally input search criteria. In the example above, region would rank 
higher than any of the stemmed variants. 

Not all queries rank their results. For example, queries that check whether a 
given string matches the value in a field cannot perform a comparison: either 
the string matches the value or it doesn’t. The same is true for checking 
whether a string is contained in a field, or begins or ends a field. 

Default assumptions
The search query language has some implicit defaults and assumptions that 
dictate how it interprets your input. In some cases, you can circumvent the 
defaults, but here is how the search engine decides what you want as the 
search results:

<STEM>—Search finds all documents that contain any stemmed variant of the 
search word or phrase. The search engine looks at the meaning of the word, 
not just its spelling. For example, if you want to search on plan, the results 
would include documents that contain planning and plans, but not those that 
contain plane or planet.

<MANY>—Search considers how often the search word or phrase appear in the 
found documents and ranks the results for frequency (or relevancy). 

<PHRASE>—Search considers words separated by spaces to be part of a 
phrase. For example, Monterey otter is interpreted as a phrase and both must be 
present and together to be found. Such a search would not find documents 
containing sea otter or Monterey Bay.

Note In any case where it’s not clear that two words are to be considered as a 
phrase, you can use parentheses for clarity. For example, 
<PHRASE> (rise "and" fall).
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OR—Search considers each word or phrase in the query separated by a comma 
to be optional, although at least one must be present. In effect, this is an 
implicit OR operation. For example, Monterey, otter is interpreted as searching 
for documents that contain either Monterey or otter. Note that angle brackets 
are not required for OR.

Search rules

To create complex searches, you can combine query operators, manipulate the 
query syntax, and include wildcard characters.

Angle brackets

With the exception of the AND, OR, NOT, and the date and numeric comparison 
operators, you need to enclose query operators in angle brackets, as in 
<CONTAINS> and <WILDCARD>.

Combining operators

You can combine several query operators into a single query to obtain precise 
results. For example, you can input the following query to limit your search to 
those documents that have Bay and Monterey but to exclude those that 
mention Aquarium

Monterey AND Bay NOT <CONTAINS> Aquarium 

You can achieve even greater precision by including some implicit phrases, as 
in the following query that finds documents that refer to the Monterey Bay 
Aquarium by its full name and also mention otters but do not refer to shark:

Monterey Bay Aquarium AND otter AND NOT shark 

Using query operators as search words

You can use any of the query operators as a search word, but you must enclose 
the word in quotation marks. For example, you could search for documents 
about the ebb and flow of the tides with the following query:

<CONTAINS> ebb "and" flow
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Canceling stemming

You can cancel the implicit stemming by using quotation marks around a word. 
For example, you can be exact by using a query such as this:

"plan"  

This search only results in documents that contain the exact word plan. It 
ignores documents with plans or planning.

Modifying operators

You can use AND, OR, and NOT to modify other operators. For example, you 
may want to exclude documents with titles that contain the phrase theme park. 
A query such as this would solve this problem:

Title NOT <CONTAINS> theme park  

Determining which operators to use 

Use the following reference to help determine which operators to use. Note 
that the query language is not case-sensitive, so <starts> and <STARTS> are 
equivalent. This document uses uppercase for clarity only.

Table 5.1 Deciding which operator to use

Type of Search Valid Operators Examples

Finding documents by date or 
numeric value comparison.

is equal to (=),
greater than (>),
greater than or equal to 
(>=),
less than (<),
less than or equal to (<=)

DATE >= 06-30-96

Finds documents created on or after 
June 30, 1996.

Finding words or phrases in 
specific document fields or in 
specific locations in the field.

<STARTS>,
<CONTAINS>,
<ENDS>,
is equal to (=)

Title <STARTS> Help  

Finds documents with titles that start 
with Help.

Finding two or more words in a 
document.

AND,
<NEAR/1>

specifications AND review 

Finds documents that contain both 
specifications and review.
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Query operators: a reference

The following table describes some commonly used operators and provides 
examples of how to use each one. All are relevance ranked except where 
explicitly noted.

Table 5.2 Query language operators

Operator Description Examples

AND Adds mandatory criteria to the search. 
Finds documents that have all of the 
specified words.

Antarctica AND mountain climb

Finds only documents containing both 
Antarctica and mountain climb plus all 
the stemmed variants, such as mountain 
climbing.

<CONTAINS> Finds documents containing the 
specified words in a document field. The 
words must be in the exact same 
sequential and contiguous order.

You can use wildcards. Only 
alphanumeric values.

Does not rank documents for relevance.

Title <CONTAINS> higher profit

Finds documents containing the phrase 
higher profit in the title. Ignores documents 
with profits higher in the title.

<ENDS> Finds documents in which a document 
field ends with a certain string of 
characters.

Does not rank documents for relevance.

Title <ENDS> draft

Finds documents with titles ending in 
draft.

equals (=) Finds documents in which a document 
field matches a specific date or numeric 
value.

Created = 6-30-96

Finds documents created on June 30, 1996.

greater than (>) Finds documents in which a document 
field is greater than a specific date or 
numeric value.

Created > 6-30-96

Finds documents created after June 30, 
1996.

greater than or 
equal to (>=)

Finds documents in which a document 
field is greater than or equal to a specific 
date or numeric value.

Created >= 6-30-96

Finds documents created on or after June 
30, 1996.
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less than (<) Finds documents in which a document 
field is less than a specific date or 
numeric value.

Created < 6-30-96

Finds documents created before June 30, 
1996.

less than or equal 
to (<=)

Finds documents in which a document 
field is less than or equal to a specific 
date or numeric value.

Created <= 6-30-96

Finds documents created on or before June 
30, 1996.

<MATCHES> Finds documents in which a string in a 
document field matches the character 
string you specify.

Ignores documents that contain partial 
matches.

Does not rank documents for relevance.

<MATCHES> employee

Finds documents containing employee or 
any of its stemmed variants such as 
employees.

<NEAR> Finds documents that contain the 
specified words. The closer the terms are 
to each other in the document, the 
higher the document's score.

stock <NEAR> purchase

Finds any document containing both stock 
and purchase, but gives a higher score to a 
document that has stock purchase than to 
one that has purchase supplies and stock 
up.

<NEAR/N> Finds documents in which two or more 
specified words are within N number of 
words from each other. N can be an 
integer up to 1000. Also ranks the 
documents for relevance based on the 
words' proximity to each other.

stock <NEAR/1> purchase

Finds documents containing the phrases 
stock purchase and purchase stock.

Ignores documents containing phrases like 
purchase supplies and stock up because 
stock and purchase do not appear next to 
each other.

When N is 2 or greater, finds documents 
that contain the words within the range 
and gives a higher score for documents 
which have the words closer together.

Table 5.2 Query language operators

Operator Description Examples
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NOT Finds documents that do not contain a 
specific word or phrase.

Note: You can use NOT to modify the OR 
or the AND operator.

surf AND NOT beach

Finds documents containing the word surf 
but not the word beach.

OR Adds optional criteria to the search. 
Finds any document that contains at 
least one of the search values.

apples OR oranges

Finds documents containing either apples 
or oranges.

<PHRASE> Finds documents that contain the 
specified phrase. A phrase is a grouping 
of two or more words that occur in a 
specific order.

<PHRASE> (rise "and" fall)  

Finds documents that include the entire 
phrase rise and fall. The and is in quotes 
to force the search to interpret it as a literal, 
not as an operator.

<STARTS> Finds documents in which a document 
field starts with a certain string of 
characters.

Does not rank documents for relevance.

Title <STARTS> Corp

Finds documents with titles starting with 
Corp, such as Corporate and Corporation..

<STEM> 
(English only)

Finds documents that contain the 
specified word and its variants.

<STEM> plan

Finds documents that contain plan, plans, 
planned, planning, and other variants with 
the same meaning stem. Ignores similarly 
spelled words such as planet and plane 
that don't come from the same stem.

<SUBSTRING> Finds documents in which part or all of a 
string in a document field matches the 
character string you specify.

Similar to <MATCHES>, but can match 
on a partial string.

Does not work with wildcards.

Does not rank documents for relevance.

<SUBSTRING> employ

Finds documents that can match on all or 
part of employ, so it can succeed with ploy. 

Note: This works with literals only. If you 
input web* , the asterisk does not work as 
a wildcard, so the search succeeds only 
with the exact “web*” string. 

Table 5.2 Query language operators

Operator Description Examples
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Using wildcards 
You can use wildcards to obtain special results. For example, you can find 
documents that contain words that have similar spellings but are not stemmed 
variants. For example, plan stems into plans and planning but not plane or 
planet. With wildcards, you can find all of these words.

<WILDCARD> Finds documents that contain the 
wildcard characters in the search string. 
You can use this to get words that have 
some similar spellings but which would 
not be found by stemming the word.

Some characters, such as * and ?, 
automatically indicate a wildcard-based 
search, so you don’t have to include the 
word <WILDCARD>.

<WILDCARD> plan*

Finds documents that contain plan, plane, 
and planet as well as any word that begins 
with plan, such as planned, plans, and 
planetopolis.

See the next section for more details and 
examples.

<WORD> Finds documents that contain the 
specified word.

<WORD> theme

Finds documents that contain theme, 
thematic, themes, and other words that 
stem from theme.

Table 5.2 Query language operators

Operator Description Examples
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Some characters, such as * and ?, automatically indicate a wildcard-based search 
and do not require you to use the <WILDCARD>operator as part of the 
expression.

Table 5.3 Wildcard operators

Character Description

* Specifies 0 or more alphanumeric characters. For example, air*  finds 
documents that contain air, airline, and airhead. 

Cannot use this wildcard as the first character in an expression. 

This wildcard is ignored in a set of ([ ]) or in an alternative pattern ({ }). 

With this wildcard, the <WILDCARD> operator is implicit.

? Specifies a single alphanumeric character, although you can use more 
than one ? to indicate multiple characters. For example, ?at  finds 
documents that contain cat and hat, while ??at  finds documents that 
contain that and chat.

This wildcard is ignored in a set of ([ ]) or in an alternative pattern ({ }).

With this wildcard, the <WILDCARD> operator is implicit.

{} An alternative pattern that specifies a series of patterns, one for each 
pattern separated by commas. For example,
<WILDCARD> ‘Chat{s, ting, ty}‘  
finds documents that contain chats, chatting, and chatty.

You must enclose the entire string in back quotes and you cannot have 
any embedded spaces.

[ ] A set that specifies a series of characters that can be 
used to find a match. For example, 
<WILDCARD> ‘[chp]at‘ 
finds documents that contain cat , hat , and pat .

You must enclose the entire string in back quotes and you cannot have 
any embedded spaces.
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Wildcards as literals

Sometimes you may want to search on characters that are normally used as 
wildcards, such as the *or?  expression. To use a wildcard as a literal, you 
must precede it with a backslash. In the case of asterisks, you must use two 
backslashes. For example, to search on a magazine with a title of Zine***, you 
would type:

<WILDCARD>Zine\\*\\*\\*

Several characters have special meaning for the search engine and require you 
to use back quotes to be interpreted as literals. The special search characters 
are listed here: 

• comma ,

• left and right parentheses ( )

• double quotation mark "

• backslash \

• at sign @

• left curly brace {

• left bracket [

• back quote ‘ (Note: You can only search on back quotes as literals if your 
server administrator has set this up.)

For example, to search for the string "a{b", you would type

^ Specifies one or more characters to exclude from a set. For example, 
<WILDCARD> ‘C[^io]t‘  finds documents that contain cat and cut, 
but not cot.

The caret (^) must be the first character after the left bracket.

- Specifies a range of characters in a set. For example, <WILDCARD> 
‘Ch[a-j]t‘  finds documents that contain any four-letter word from 
chat to chjt. 

Table 5.3 Wildcard operators

Character Description
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<WILDCARD>‘a{b‘

For another example, if you wanted to search on the string "c‘t", which contains 
a back quote, you would type 

<WILDCARD>‘c‘‘t‘
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6
Agents
Overview
Netscape Web Publisher allows you to use server agents to manage server files 
and folders. Agents act as watchdogs for you, watching for a specific event or 
time, and then performing a task for you. For example, you could set up an 
agent to notify you when a specific URL has been updated. The notification 
could be an email message or a posting to a newsgroup.

An agent is stored on the server, so you must be connected to the server when 
you create the agent although you do not need to be connected when the 
agent is activated. The agent resides on the server until it is deleted or 
completes the assigned task. 

Note If your system administrator has turned web publishing off, all agents for the 
server are also turned off and you cannot use Netscape Web Publisher to 
access agent setup and list commands. 

Types of agents
There are several types of agents, each of which has a particular use. The 
following sections mention some sample events for each category.
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Timer agents

Timer agents respond to time-related events that occur as a result of the date or 
time. You can submit an agent to activate at the following times:

• On a specified date and time

• At a recurring time (for example, every Tuesday at 10 a.m.)

• At periodic intervals (for example, every five hours)

Document agents

Document agents respond to document-related events that take place when 
something has occurred to the indicated document. Some examples are:

• A document is changed, moved, copied, or deleted

• Someone views or modifies a document attribute

• A document is locked or unlocked

Directory agents

Directory agents respond to directory-related events that take place when 
something has occured to the indicated directory. Some examples are:

• A directory is changed, moved, copied, or deleted

• A directory is added

• Someone lists a directory 

• Someone views or modifies a directory attribute

Search agents

Search agents execute periodically, searching the content of server document 
collections such as the server’s web publishing collection. When documents are 
found that match the search criteria, they are listed as the search results. You 
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can limit the content search to recently modified documents or you can extend 
the search to include all server documents. Some examples of search agent 
tasks are:

• Check the server at 5 a.m. every Monday morning for all documents that 
have been modified in the preceding week.

• Check the server at 5 a.m. every Monday morning for all documents that 
contain the string “JavaScript” that have been modified in the preceding 
week.

• Check the server at 5 a.m. on the first of each month for all documents 
with the word Netscape in their title.

Agent actions
When an event occurs that an agent is monitoring, the agent activates and 
begins to perform its assigned actions. For example, typical agent actions 
include:

• Sending an email message 

• Posting a news article to one or more newsgroups

• Performing an HTTP operation to post to a URL or to get a URL

Access control and secure servers
Your server administrator can configure how your server manages agents. By 
default, you can view and modify only your own agents. In addition, the server 
checks your access control permissions when you create an agent, only autho-
rizing valid users. The server again checks access permissions when the agent 
activates, making sure that the document or folder can be accessed. Agents can 
only perform operations that you are authorized to perform. 
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Secure servers

You can create an agent on a secure server as well as on a regular non-secure 
server, but when the agent is activated, it cannot perform HTTP Get or Post 
actions on secure servers because the agent does not provide authentication 
data. Likewise, if an agent is intended to send emails or post to newsgroups on 
secure servers, these actions will fail because the agent cannot validate itself. 

HTTP Get or Post actions that include an URL under an access control 
restriction will also fail, even if the URL is on a regular non-secure server.

When an agent action fails, the notification email is still sent, but it will only 
include the parts that succeed. For example, if a user defined 

If a search agent is created on a secure server, it will fail when the search 
results are returned to the server. Although the search agent runs on the same 
secure server where it was created, the search fails because the server requires 
authentication, which the agent cannot provide.

Accessing agent services
To access agent services through Web Publisher, you can use the Web 
Publisher menu commands or, if you are at the Netscape Web Publisher 
Services form, you can use the Agent Services link. 

From the Web Publisher applet window:

1. From the Services menu, choose Create Agent or Agent Services. The Agent 
Services form is displayed. 

If you had selecteda file in the Web Publisher window and you chose 
Create Agent, the New Document Agent page is displayed in the right frame 
document with your file listed as the document to monitor. If you had 
chosen a folder instead, the New Directory Agent page is displayed with 
your folder listed as the directory to monitor.

From the Netscape Web Publisher Services window:

1. Click the Agent Services link. The Agent Services form appears.
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Figure 6.1  The agent services screen 

Standard and advanced options
There is a link at the bottom of the left frame that allows you to access 
additional options for creating agents.

Most users perform a standard set of agent tasks, and the Standard options 
provide a simplified interface for these tasks. If you require additional 
capabilities, you can access a more complex interface by selecting the 
Advanced options.
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Creating agents
You can create agents with a standard set of options or with additional 
(advanced) options. Once you create an agent, you are considered the owner 
of that agent and only you can view or modify it. 

Creating document agents

To create a document agent using the standard set of options, begin by 
obtaining the New Document Agent page. 

Figure 6.2  The standard New Document Agent page 

To create an agent with the standard set of options:
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1. Click the “Standard Options” link at the bottom of the left frame.

If it is labeled “Advanced Options,” you are already at the standard set of 
options, so you do not need to choose it.

2. Click the Document Agent link in the New Agent frame. The New 
Document Agent form appears, with instructions to enter information as 
requested for each of the steps.

To create an agent with the advanced set of options:

1. Click the “Advanced Options” link at the bottom of the left frame.

If it is labeled “Standard Options,” you are already at the advanced set of 
options, so you do not need to choose it.

2. Click the Document Agent link in the New Agent frame. The New 
Document Agent form appears, with instructions to enter information as 
requested for each of the steps.

Using the standard options

To create a document agent using the standard set of options, follow these 
steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only 17 characters are visible at at time.

2. Type in the URI of the document (file) you want the agent to monitor. You 
need to include a slash before the filename so the server can locate it 
correctly, as in /index.html .

In this step, you also select the Web Publisher event you want to activate 
the agent from the scrollable list. If the document is modified or otherwise 
manipulated through some other file management program, the agent is not 
activated. These are the actions you can monitor:

• Modify—The document is published.

• View—The document is viewed (that is, “hit” or accessed).

• Delete—The document is deleted.
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• Move—The document is moved or renamed.

• Copy—The document is copied.

• View Document Attributes—The document’s attributes are viewed.

• Modify Document Attributes—The document’s attributes are modified.

• Document Locked—The document is locked.

• Document Unlocked—The document is unlocked.

3. Type in the email address of the users or newgroups to notify when the 
event occurs for the document. You can enter more than one email address 
or newsgroup, separated by commas.

4. Enter any user-specified message contents you want added to the email sent 
as notification.

5. Type in the email address of the person or groups to notify when the agent 
is created. You can enter more than one email address, separated by 
commas, but only the first address is used in the standard Reply To field. 

6. Click Create Agent to create the agent or Clear to clear the fields.

Using the advanced options

To create a document agent using the advanced set of options, follow these 
steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only the first 17 characters are visible at a time. 

2. Type in the URI of the document (file) you want the agent to monitor. You 
need to include a slash before the filename so the server can locate it 
correctly, as in /index.html .

In this step, you also select the Web Publisher event you want to activate 
the agent from the scrollable list. If the document is modified or otherwise 
manipulated through some other file management program, the agent is not 
activated. These are the actions you can monitor:

• Modify—The document is published.
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• View—The document is viewed (that is, “hit” or accessed).

• Delete—The document is deleted.

• Move—The document is moved or renamed.

• Copy—The document is copied.

• View Document Attributes—The document’s attributes are viewed.

• Modify Document Attributes—The document’s attributes are modified.

• Document Locked—The document is locked.

• Document Unlocked—The document is unlocked.

3. Type in the email address of the users or newsgroups to notify when the 
event occurs for the document. You can enter more than one email address 
or newsgroup, separated by commas.

4. You can define your message contents in these ways:

• Type in a user-specified message to be included as part of the 
notification. 

• Identify a URL whose contents are to be included as part of the 
notification.

• Identify a URL to which you want to perform an HTTP Post. 

• You can define the URL-encoded message you want included as part of 
the HTP Post. 
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Figure 6.3  Message contents 

5. Type in the email address of the person or groups to notify when the agent 
is created. You can enter more than one email address, separated by 
commas, but only the first address is used in the standard Reply To field. 

6. You can change the maximum activations for an agent or its expiration date, 
although you cannot extend beyond the limits set by your server 
administrator. .

7. Click Create Agent to create the agent or Clear to clear the fields.

Note If you are using HTTP Post operations, you may find it easiest to use some of 
the Agent API code provided as samples in the default installation of Netscape 
Enterprise Server 3.0. You can access the sample code files in the /plugins/
agents/examples  directory for your server. The API code builds an HTTP 
Post method for you that you can revise and use as the Post message contents. 
For example, the following code appears in the agentapi.cpp  file.

...
if (urltopost) {

//build the post message
sprintf(header, "Content-Length:%d\n\
Content-Type: application/x-www-form-urlencoded’ charset=US-ASCII\n\
Content-Transfer-Encoding: 7-bit",strlen(postmessage));
sprintf(post_msg, "%s\n\n%s\n", header, postmessage);

}...
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Creating directory agents 

To create a directory agent using the standard set of options, begin by 
obtaining the New Directory Agent form. 

Figure 6.4  The standard New Directory Agent page 

To create an agent with the standard set of options:

1. Click the “Standard Options” link at the bottom of the left frame.

If it is labeled “Advanced Options,” you are already at the standard set of 
options, so you do not need to choose it.

2. Click the Directory Agent link in the New Agent frame. The New Directory 
Agent form appears, with instructions to enter information as requested for 
each of the steps.
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To create an agent with the advanced set of options:

1. Click the “Advanced Options” link at the bottom of the left frame.

If it is labeled “Standard Options,” you are already at the advanced set of 
options, so you do not need to choose it.

2. Click the Directory Agent link in the New Agent frame. The New Directory 
Agent form appears, with instructions to enter information as requested for 
each of the steps.

Using the standard options

To create a directory agent using the standard set of options, follow these steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only 17 characters are visible at a time.

2. Type in the URI of the directory (folder) you want the agent to monitor. 
You need to include a slash before the directory’s name so the server can 
locate it correctly, as in /products .

In this step, you also select the Web Publisher event you want to activate 
the agent from the scrollable list. If the directory is modified or otherwise 
manipulated through some other file management program, the agent is not 
activated. These are the actions you can monitor:

• Document added/deleted—A document in the agent directory is added 
or deleted.

• Directory Listed—The directory contents are listed, which occurs when 
a directory is opened in the Web Publisher file window.

• Delete—The directory is deleted.

• Move Directory—The directory is moved or renamed.

• Copy Directory—The directory is copied.

• View Directory Attributes—The directory’s attributes are viewed.

• Modify Directory Attributes—The directory’s attributes are modified.
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3. Type in the email address of the users or newgroups to notify when the 
event occurs. You can enter more than one email address, or 
newsgroup,separated by commas. 

4. Enter any user-specified message contents you want added to the email sent 
as notification.

5. Type in the email address of the person or groups to notify when the agent 
is created. You can enter more than one email address, separated by 
commas, but only the first address is used in the standard Reply To field.

6. Click Create Agent to create the agent or Clear to clear the fields.

Using the advanced options

To create a directory agent using the advanced set of options, follow these 
steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only the first 17 characters are visible at a time. 

2. Type in the URI of the directory (folder) you want the agent to monitor. 
You need to include a slash before the filename so the server can locate it 
correctly, as in /products .

In this step, you also select the Web Publisher event you want to activate 
the agent from the scrollable list. If the document is modified or otherwise 
manipulated through some other file management program, the agent is not 
activated. These are the actions you can monitor:

• Document added/deleted—A document in the agent directory is added 
or deleted.

• Directory Listed—The directory contents are listed, which occurs when 
a directory is opened in the Web Publisher file window.

• Delete—The directory is deleted.

• Move Directory—The directory is moved or renamed.

• Copy Directory—The directory is copied.

• View Directory Attributes—The directory’s attributes are viewed.
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• Modify Directory Attributes—The directory’s attributes are modified.

3. Type in the email address of the person or groups to notify when the event 
occurs for the document. You can enter more than one email address, 
separated by commas. 

4. You can define your message contents in these ways (See Figure 6.3):

• Type in a user-specified message to be included as part of the 
notification. 

• Identify a URL whose contents are to be included as part of the 
notification.

• Identify a URL to which you want to perform an HTTP Post. 

• You can define the URL-encoded message you want included as part of 
the HTP Post. 

5. Type in the email address of the person or groups to notify when the agent 
is created. You can enter more than one email address, separated by 
commas, but only the first address is used in the standard Reply To field. 

6. You can change the maximum activations for an agent or its expiration date, 
although you cannot extend beyond the limits set by your server 
administrator. .

7. Click Create Agent to create the agent or Clear to clear the fields.

Note If you are using HTTP Post operations, you may find it easiest to use some of 
the Agent API code provided as samples in the default installation of Netscape 
Enterprise Server 3.0. You can access the sample code files in the /plugins/
agents/examples  directory for your server. The API code builds an HTTP 
Post method for you that you can revise and use as the Post message contents. 
For example, the following code appears in the agentapi.cpp  file.

...
if (urltopost) {

//build the post message
sprintf(header, "Content-Length:%d\n\
Content-Type: application/x-www-form-urlencoded’ charset=US-ASCII\n\
Content-Transfer-Encoding: 7-bit",strlen(postmessage));
sprintf(post_msg, "%s\n\n%s\n", header, postmessage);

}...
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Creating timer agents

To create a timer agent using the standard set of options, begin by obtaining 
the New Timer Agent form. 

To create an agent with the standard set of options:

1. Click the “Standard Options” link at the bottom of the left frame.

If it is labeled “Advanced Options,” you are already at the standard set of 
options, so you do not need to choose it.

2. Click the Timer Agent link in the New Agent frame. The New Timer Agent 
form appears, with instructions to enter information as requested for each 
of the steps.

To create an agent with the advanced set of options:

1. Click the “Advanced Options” link at the bottom of the left frame.

If it is labeled “Standard Options,” you are already at the advanced set of 
options, so you do not need to choose it.

2. Click the Timer Agent link in the New Agent frame. The New Timer Agent 
form appears, with instructions to enter information as requested for each 
of the steps.

Using the standard options

To create a timer agent using the standard set of options, follow these steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only 17 characters are visible at a time.
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Figure 6.5  The timer date and time information 

2. Indicate when you want the agent to activate by making a selection and 
providing its associated data:

• Once only, or Now (to make the agent active as soon as it is created) 

If you do not check Now as the activation time, type in the exact date and 
time when you want the agent to activate. .

• Every (periodically on a regular basis)

Type in a number and select the periodic interval from the drop-down list: 
minutes, hours, days, months, or years. 

Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

• On the same day of the week

Check the checkbox for one or more days of the week on which the agent 
is to execute.

Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.
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3. Type in the email address of the user or newgroups to notify when the 
event occurs for the document. You can enter more than one email address 
or newsgroup, separated by commas..

4. Enter any user-specified message contents you want added to the email sent 
as notification.

5. Type in the email address of the person or groups to notify when the agent 
is created.You can enter more than one email address, separated by 
commas., but only the first address is used in the standard Reply To field.

6. Click Create Agent to create the agent or Clear to clear the fields.

Using the advanced options

To create a timer agent using the advanced set of options, follow these steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only 17 characters are visible at a time.

2. Indicate when you want the agent to activate by making a selection and 
providing its associated data (See Figure 6.5):

• Once only, or Now (to make the agent active as soon as it is created) 

If you do not check Now as the activation time, type in the exact date and 
time when you want the agent to activate. .

• Every (periodically on a regular basis)

Type in a number and select the periodic interval from the drop-down list: 
minutes, hours, days, months, or years. 

Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

• On the same day of the week

Check the checkbox for one or more days of the week on which the agent 
is to execute.
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Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

3. Type in the email address of the user or newgroups to notify when the 
event occurs for the document. You can enter more than one email address 
or newsgroup, separated by commas..

4. You can define your message contents in these ways (See Figure 6.3):

• Type in a user-specified message to be included as part of the 
notification. 

• Identify a URL whose contents are to be included as part of the 
notification.

• Identify a URL to which you want to perform an HTTP Post. 

• You can define the URL-encoded message you want included as part of 
the HTP Post. 

5. Type in the email address of the person or groups to notify when the agent 
is created. You can enter more than one email address, separated by 
commas, but only the first address is used in the standard Reply To field. 

6. You can change the maximum activations for an agent, although you 
cannot extend beyond the limit set by your server administrator. .

7. Click Create Agent to create the agent or Clear to clear the fields.

Note If you are using HTTP Post operations, you may find it easiest to use some of 
the Agent API code provided as samples in the default installation of Netscape 
Enterprise Server 3.0. You can access the sample code files in the /plugins/
agents/examples  directory for your server. The API code builds an HTTP 
Post method for you that you can revise and use as the Post message contents. 
For example, the following code appears in the agentapi.cpp  file.

...
if (urltopost) {

//build the post message
sprintf(header, "Content-Length:%d\n\
Content-Type: application/x-www-form-urlencoded’ charset=US-ASCII\n\
Content-Transfer-Encoding: 7-bit",strlen(postmessage));
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sprintf(post_msg, "%s\n\n%s\n", header, postmessage);
}...

Creating search agents 

To create a search agent using the standard set of options, begin by obtaining 
the New Search Agent form. 

To create an agent with the standard set of options:

1. Click the “Standard Options” link at the bottom of the left frame.

If it is labeled “Advanced Options,” you are already at the standard set of 
options, so you do not need to choose it.

2. Click the Search Agent link in the New Agent frame. The New Search Agent 
form appears, with instructions to enter information as requested for each 
of the steps.

To create an agent with the advanced set of options:

1. Click the “Advanced Options” link at the bottom of the left frame.

If it is labeled “Standard Options,” you are already at the advanced set of 
options, so you do not need to choose it.

2. Click the Search Agent link in the New Agent frame. The New Search Agent 
form appears, with instructions to enter information as requested for each 
of the steps. This is a Java applet that provides additional searching 
capabilities.

Using the standard options

To create a search agent using the standard set of options, follow these steps:

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only 17 characters are visible at a time.

2. Indicate when you want the agent to activate by making a selection and 
providing its associated data (See Figure 6.5):

• Once only, or Now (to make the agent active as soon as it is created) 
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If you do not check Now as the activation time, type in the exact date and 
time when you want the agent to activate. .

• Every (periodically on a regular basis)

Type in a number and select the periodic interval from the drop-down list: 
minutes, hours, days, months, or years. 

Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

• On the same day of the week

Check the checkbox for one or more days of the week on which the agent 
is to execute.

Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

3. Type in the email address of the user or newgroups to notify when the 
event occurs for the document. You can enter more than one email address 
or newsgroup, separated by commas..

4. You can define your message contents in these ways:

• Choose the scope of your search by clicking the All Documents or 
Document Updated Since Last Activation.

• Choose from the drop-down list the collection you want to search 
through. The default is the Web Publishing collection. See Chapter 5, 
“Search” for more information about performing searches.

• In the Search For field, enter the word or phrase you want to search for. 
Enter * to collect all documents that have been updated since the last 
search

• Type in a user-specified message to be included as part of the 
notification. 
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5. Type in the email address of the person or groups to notify when the agent 
is created.You can enter more than one email address, separated by 
commas., but only the first address is used in the standard Reply To field.

6. Click Create Agent to create the agent or Clear to clear the fields.

Using the advanced options

When you choose to create an advanced search agent, you do so in a Java 
applet that guides you through making a search query. Note that to use the 
applet, you must have Java enabled for your browser. 

Note Much of the search functionality is discussed at length in Chapter 5, “Search.” 
Read that chapter for further details on search queries. The search agent uses 
the same query language, with the same set of rules and restrictions.

To create a search agent using the advanced set of options, follow these steps :

1. Type in the name you want to give the agent. Choose a name that helps 
you remember its function. Only 17 characters are visible at a time.

2. Indicate when you want the agent to activate by making a selection and 
providing its associated data (See Figure 6.5):

• Once only, or Now (to make the agent active as soon as it is created) 

If you do not check Now as the activation time, type in the exact date and 
time when you want the agent to activate. .

• Every (periodically on a regular basis)

Type in a number and select the periodic interval from the drop-down list: 
minutes, hours, days, months, or years. 

Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

• On the same day of the week

Check the checkbox for one or more days of the week on which the agent 
is to execute.
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Enter the beginning time for the agent’s activation period, or check Now to 
make the agent active as soon as it is created. 

Enter the time when the agents expires. You cannot create an agent that 
extends beyond your server’s default expiration date for agents.

3. Type in the email address of the user or newgroups to notify when the 
event occurs for the document. You can enter more than one email address 
or newsgroup, separated by commas..

4. You can define your message contents in these ways:

• Choose the scope of your search by clicking the All Documents or 
Document Updated Since Last Activation.

• Define your search query by using the embedded Java applet.

Figure 6.6  The Java search applet 

Java search You can use the embedded Java applet to guide you through constructing a 
search query. This is especially useful if you want to build a query that has 
several parts, say searching for a word in the documents’ content as well as a 
specific attribute value. 

1. Select the collection you want to search against by choosing an item 
from the Search In drop-down list.

2. Select the type of search element you want to search for from the drop-
down list in the Search For field. You can search on these elements:
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• words: any word or words in the document’s content. If you input more 
than one word, they can be found in any order in the document and do 
not need to be next to each other.

• words in proximity: two or more words in a document, with a relevency 
ranking for higher proximity (the closer the words are to each other, the 
higher the score).

• phrase: two or more words in a document next to each other in the 
exact same sequence as in the query. 

• literal: one or more words that are to be interpreted exactly as they are, 
without stemming or rearranging the word sequence.

• attribute: a file property that has been defined for the collection. These 
are listed in a drop-down list.

• any pattern: any text pattern.

3. If you selected attribute from the Search For drop-down list, two 
additional drop-down lists are displayed. One lists the file attributes that 
are available for the collection and the other lists the operators you can 
use to search against the attributes: contains , ends , starts , 
substring , and matches . See “Query operators: a reference” in 
Chapter 5, “Search” for information about these operators.

4. To construct queries with multiple AND and OR statements, click the 
“and search for” and “or search for” radio buttons in the lower left part 
of the form. 

5. Click Add Line after creating a query to add another statement. As the 
query is being constructed, you can see it displayed at the bottom of the 
applet. You can click Undo Line to remove the last line you added or 
Clear to remove the entire query.

6. Click Search to check your search query or Clear to clear the query.

Here you return to the HTML form, where you can define some additional 
agent message contents in these ways (See Figure 6.3):

• Type in a user-specified message to be included as part of the 
notification. 
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• Identify a URL whose contents are to be included as part of the 
notification.

• Identify a URL to which you want to perform an HTTP Post. 

• You can define the URL-encoded message you want included as part of 
the HTP Post. 

1. Type in the email address of the person or groups to notify when the agent 
is created. You can enter more than one email address, separated by 
commas, but only the first address is used in the standard Reply To field. 

2. You can change the maximum activations for an agent or its expiration date, 
although you cannot extend beyond the limits set by your server 
administrator. .

3. Click Create Agent to create the agent or Clear to clear the fields.

Note If you are using HTTP Post operations, you may find it easiest to use some of 
the Agent API code provided as samples in the default installation of Netscape 
Enterprise Server 3.0. You can access the sample code files in the /plugins/
agents/examples  directory for your server. The API code builds an HTTP 
Post method for you that you can revise and use as the Post message contents. 
For example, the following code appears in the agentapi.cpp  file.

...
if (urltopost) {

//build the post message
sprintf(header, "Content-Length:%d\n\
Content-Type: application/x-www-form-urlencoded’ charset=US-ASCII\n\
Content-Transfer-Encoding: 7-bit",strlen(postmessage));
sprintf(post_msg, "%s\n\n%s\n", header, postmessage);

}...

Viewing and managing agents
You view only those agents that you have created. Once you are viewing an 
agent, you can perform some additional management tasks for it: You can 
modify certain fields, you can delete the agent, and you can disable and 
reenable an agent.

To view an agent, follow these steps:
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1. In the left frame, select an agent from the scrollable View Agent list. All of 
your agents are listed.

2. Click the View button.

3. The agent’s information is displayed in the right frame. This data differs 
according to the type of agent you are viewing. You can now modify, 
delete, and disable the agent.

Viewing document or directory agents
When you view a document or directory agent, data is displayed that is specific 
for that type of agent. 

• Agent name—The name of your agent.

• Agent ID—The agent’s internal identifier.

• Status—The current status for the agent: enabled or disabled.

• Type of agent—The type of agent (document or directory).

• Document (or Directory) monitored—The URI of the file (or folder) that is 
monitored by the agent.

• For event—The event for which the file is monitored.

• Activations—The number of times the agent has already been activated.

• Last activated—The date and time of the last agent activation.

• Created—The date and time when the agent was created.

• Last modified—The date and time of the last modification to the agent.

• Creation notification to—The email address to which notification was sent 
when the agent was created.

• Message contents—There are several fields that display whatever message 
contents are associated with this agent.
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Viewing timer and search agents

When you view a timer or search agent, data is displayed that is specific for that 
type of agent. 

• Agent name—The name of your agent.

• Agent ID—The agent’s internal identifier.

• Type of agent—The type of agent (timer or search).

• Type of Timer—The type of timer agent (once only, periodic, or weekday).

• Start time—The date and time at which the timer agent is to be activated.

• Next Activation—The date and time at which the agent will next be 
activated.

• Activations—The number of times that the agent has already been activated.

• Last activated—The date and time of the last agent activation.

• Created—The date and time when the agent was created.

• Last modified—The date and time of the last modification to the agent.

• Creation notification to—The email address to which notification was sent 
when the agent was created.

• Message contents—There are several fields that display whatever message 
contents are associated with this agent.

Modifying an agent

You can modify most of the agent options. For document and directory agents, 
you cannot change the document (or directory) and event that the agent is 
monitoring. For timer and search agents, you cannot change the timing of the 
agent’s activation. If you wish to modify the unmodifiable fields, you must 
delete the agent and create a new agent. 

To modify an agent:
128 Netscape Web Publisher User’s Guide



Viewing and managing agents
1. View the agent. See “Viewing document or directory agents” or “Viewing 
timer and search agents” for the steps for this.

2. You can modify the message contents, the maximum activations allowed for 
the agent, and, for document and directory agents, the agent’s expiration 
date..

3. Click the Modify Agent button at the bottom of the frame.

Deleting an agent

1. View the agent. See “Viewing document or directory agents” or “Viewing 
timer and search agents” for the steps for this.

2. Click the Delete Agent button at the bottom of the frame. A confirmation 
dialog box is displayed.

3. Click OK to delete the agent.

Disabling an agent

1. View an enabled agent. See “Viewing document or directory agents” or 
“Viewing timer and search agents” for the steps for this.

2. Click the Disable Agent button at the bottom of the frame. 

This button changes to Enable Agent once the agent has been disabled.

Enabling a disabled agent

1. View a disabled agent. See “Viewing document or directory agents” or 
“Viewing timer and search agents” for the steps for this.

2. Click the Enable Agent button at the bottom of the frame.

This button changes to Disable Agent once the agent has been disabled.
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Managing all your agents
You can enable, disable, or delete all of your agents at once. These actions only 
apply to agents that you created. To do this:

1. Click the “Advanced Options” link at the bottom of the left frame.

If it is labeled “Standard Options,” you are already at the advanced set of 
options, so you do not need to choose it.

To enable all of your agents simultaneously: 

1. Click the Enable All button

To disable all of your agents simultaneously: 

1. Click the Disable All button

To delete all of your agents simultaneously: 

1. Click the Delete All button. A confirmation dialog box is displayed.

2. Click OK to delete all your agents.

3.
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7
Access control
Overview
You can control who accesses your Web Publisher documents and directories 
and what operations different users or different groups of users can perform 
upon them. You can completely prohibit access to a file or folder or you can 
restrict access to certain authenticated users.

Note You can display or modify access control only for your own files or folders. If 
you want to define the access permissions for a file or folder that has no 
owner, you must first go to the Web Publisher Services page and use the 
Properties form to assign ownership to yourself. See the section, “Ownership of 
files and folders,” for more information about this topic.

Access control is based on a hierarchy of rules that specify certain restrictions. 
A set of rules is called an access control list (ACL). The access control hierarchy 
is based on the URL Path or file path, with ACL rules cascading from the top 
down through each progressively lower layer of directories and subdirectories 
until it reaches the file. When a request for access is made, the server goes in 
turn through each rule, continuing until it encounters a rule that prevents it 
from continuing or comes to the last rule for that resource.
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User authentication
You identify yourself by entering your user name and password in a dialog box 
or by using a client certificate installed in your web browser, such as Netscape 
Navigator or Netscape Communicator. 

If your server isn’t handling authentication for you with certificates, you must 
be defined in the server’s users and groups database, which can be either a file 
stored on the web server computer or an LDAP server on a remote computer 
(for example, a computer running Netscape Directory Server). 

When you attempt to access a file or directory that has User-Group 
authentication, the web browser displays a dialog box asking you to enter your 
user name and password. Figure 7.1 shows the default Netscape Enterprise 
Server authentication dialog box.

Figure 7.1  The authentication dialog box.

After entering the information, you are either allowed to access the file or 
directory listing requested or you are denied access. You can be denied access 
because you are not in the Users and Groups database, and are therefore 
unknown to the server, or because you have been specifically denied access in 
an access control rule.

Web Publisher access permissions
Web Publisher has many operations that are restricted to the broad category of 
valid server user. Many ACL rules, such as that for agents services, simply 
require a user to be valid for the server. That is, users who are defined in the 
server’s users database. 
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When you start Web Publisher, you are immediately prompted with the user 
name authorization dialog box. You can leave this blank and operate as an 
anonymous user, but as soon as you attempt to perform an operation restricted 
to a valid user, you are again prompted for your user name. At this point, you 
are also asked to enter your password, and only authenticated users can 
continue with the operation.

Ownership of files and folders
Web Publisher files and folders can be owned by individual users. Only the 
owner of a file or folder can define its access control definitions or reassign its 
ownership. If a file or folder has no owner, noone can modify its access 
control. As discussed in the sections “Setting access: an example” and “Setting 
users and groups,” you can define an access control definition that restricts 
certain operations to the user who is the current owner of a file or folder, even 
when ownership is reassigned.

Your server administrator can do a bulk ownership assignment for you, you can 
assign ownership for an individual file or folder through the Web Publisher 
properties page, or you can become the owner of a file or folder as a result of 
an automatic assignment by Web Publisher when you perform certain actions.

Note Locked files have a lock owner, which is not the same as being the file’s owner. 
All a lock owner owns is the lock placed on a file. Only they can unlock their 
lock, with one exception: the server administrator can unlock any file lock.

Manually assigning ownership 

You can use the properties page that is part of the Web Publisher Services form 
to manually assign ownership of a file or folder. You an only modify the Owner 
property is two cases:

• You own the file or folder.

• The file or folder has no owner.
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In the first case, if you are the owner of a file or folder, you can reassign its 
ownership to another user. Once you give away ownership, you no longer 
have any owner privileges. Only the new owner can modify the Owner field 
and the access control from then on.

In the second case, if there is no owner yet, you can make yourself or another 
user the owner. As with the previous case, if you make another user the owner, 
you lose your ability to modify the Owner field or the access control from then 
on.

Automatic assignment
When you use certain operations on files or folders without an owner, Web 
Publisher automatically assigns you as the owner. If a file or folder already has 
an owner, Web Publisher does not reassign ownership. When you perform one 
of these operations on a folder, you are also assigned as owner to all its files.

Web Pub operations that assign ownership to files or folders that have no 
owner:

• copy (ownership is assigned to the newly copied files and folders, not the 
originals)

• move 

• rename

• upload 

• edit (although ownership has little effect until you unlock the file by 
publishing it)

• start version control
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Setting access: an example
You can restrict access to the files and folder that you own. This section takes 
you through an example of restricting access to the owner of a file. In the 
example, the chosen file is the index.html  file for the default document 
directory. The steps given are the same ones you would use for defining access 
control rules for any file or folder. 

1. Select the index.html  file in the Web Publisher applet window.

2. At this point, there are three ways to obtain the access control interface 
from Web Publisher:

• From the Services menu, choose Access Control.

• Click the Information toolbar button to display the Web Publisher Services 
page, and then click the Access Control button.

• In the URL field of your browser, type in the following URL:

http:// yourServer /oneacl/index.html

The access control window divides into two frames that you use to set the 
access control rules. If the file or folder has no access control, the top frame 
is initially empty. 

3. Click New Line to get a new default rule. Leave this unchanged. The default 
rule that you begin with denies everyone everything. Once you’ve done 
this, you can expand the access to include specified users and groups, as in 
the next step.

4. Click New Line again to get another default ACL rule as the bottom row of 
the table. You can use the up and down arrows in the left column to move 
a rule, if needed.
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Figure 7.2  A sample ACL for the owner of a file 

5. You can allow access to this file by clicking the Deny link in the Action 
column. The bottom frame now displays the Allow/Deny form. See the 
section See “Setting actions” for more details.

6. Click Allow and then click Update to return to the top frame with the new 
data.

7. You can allow access to a specific user by clicking the Anyone link in the 
Users/Groups column. The bottom frame now displays the User/Group 
form. By default, there is no authentication, meaning anyone can access the 
resource. See “Setting users and groups” for more details.

8. You can restrict access to a computer or network by clicking the Anyplace 
link in the From Host column. See “Specifying host names and IP 
addresses” for more details on how to use this advanced option.

9. You can restrict access to certain operations by clicking the All link in the 
Rights column. The bottom frame now displays the Access Rights form. By 
default, the user has access to all operations. See “Setting rights” for more 
details.

To restrict the rule to all except write and delete operations, uncheck these 
two checkboxes, and then click Update to return to the top frame with the 
new data.

10. Add another new line, this time allowing the owner to have write and 
delete access as well. Complete steps 4-6. 
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Then to restrict access to the owner of a file, type owner  in the User field 
under “Authenticated People Only,” and then click Update to return to the 
top frame with the new data. 

11. In most cases, this is all you need to do to define an ACL for your file, so 
click Submit to set up this ACL for your index.html  file. See “Additional 
options” for details about other options you can use.

If you click Revert, the server removes any changes you made to the rules 
from the time you first opened the two-frame window. Be cautious when 
using Revert because you can’t restore your edits. In most cases, it is safer 
to delete the rule lines individually by clicking the Trash can icon on the 
end of each line.

Access control: the details
The Web Publisher access control interface allows a wide and flexible range of 
access definitions. The interface has two frames, with the top part displaying 
the ACL rules that are being updated with new or modified data from the 
several different forms that are shown in the bottom part. The top frame has 
several icons and checkboxes that you can use to customize your access 
control. 

Setting actions

You can specify the action the server takes when a request matches the access-
control rule. 

• Allow means the users or computers can access the requested resource.

• Deny means the users or computers cannot access the resource.

Setting users and groups

You can restrict access to your file or folder based on the user who is making 
the access request. With user and group authentication, users are prompted to 
enter a user name and password before they can access the resource specified 
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in the access-control rule. The web server uses a list of users and groups to 
determine access rights for the user requesting a resource. This information is 
stored either in a database on the web server computer or in an LDAP server 
such as Netscape Directory Server.

You can allow or deny access to everyone in the database, or you can allow or 
deny specific people by using wildcard patterns or lists of users or groups. You 
need to use a person’s user name as defined to the server, not their actual 
name. For example, you could restrict access to JSmith only, or to the owner of 
a file, or to anyone who’s name begins with the letter s (by entering the 
wildcard pattern s* ).

When you click the Users/Groups link, a form appears in the bottom frame. 
The following list describes the options in the form:

• Anyone (No Authentication) is the default and means anyone can access the 
resource without having to enter a user name or password. However, the 
user might be denied access based on other settings, such as host name or 
IP address.

• Authenticated people only means all users requesting the resource have to 
enter a valid user name and password before gaining access to the 
resource.

• All in the authentication database matches any user who has an entry in the 
database. 

• Only the following people lets you specify certain users and groups to 
match. You can list the users and groups of users individually by separating 
the entries with commas. Or, you can enter a wildcard pattern, such as 
*Smith .

• Group matches all users in the groups you specify. 

• User matches the individual users you specify. If you want to restrict 
access to owners, enter owner  here.

• Prompt for authentication lets you customize the message that appears in 
the authentication dialog box. The default text, “Enterprise Server” is shown 
in figure. Depending on the operating system, the user sees about the first 
40 characters of the prompt. 
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• Netscape Navigator and Netscape Communicator cache the user name and 
password. This means that while you continue to use the same browser, 
you do not have to reenter your user name and password. 

• Authentication Methods specifies the method the server uses when getting 
authentication information from the client. Do not change this setting 
without consulting with your server administrator. 

• Authentication Database lets you select a database that the server uses to 
authenticate users. Do not change this setting without consulting with your 
server administrator.

Setting rights
You can set access rights to your Web Publisher files and directories. That is, in 
addition to allowing or denying all access rights, you can specify a rule that 
allows or denies partial access rights. For example, you can give people read-
only access rights to your files, so they can browse a file but cannot edit it. 

When you create an access-control rule, the default access rights are set to all 
access rights. To change access rights, click the Rights link in the top frame, and 
then check or uncheck the access rights you want to set for a particular rule. 
The following list describes each access right you can check:

• Read access lets a user view a file.

• Write access lets a user change a file’s content or properties.

• Execute access applies to server-side applications, such as CGI programs 
and Java applets.

• Delete access means a user can delete, move, or rename a file or directory. 

• List access means the user can get a list of the files in a folder. If this is not 
checked, the user cannot open the folder in the Web Publisher window.

• Info access maps to the HTTP Options method.
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The access control window
There are some special graphical elements in the ACL window that help you 
rearrange and delete individual rules. There is also a checkbox that allows you 
to redefine what users see when they are denied access to a resource. 

Moving rules up and down

Rules are applied in the order in which the server encounters them. Once you 
define a rule, you can use the arrows on the left of each rule to rearrange the 
sequence of rules for a resource. This is especially useful when you want to 
temporaily define an absolute rule that blocks access to later rules. By moving 
the rule up in the sequence, you don;t need to delete the rule and recreate it 
later. Just place it below the absolute rule, and the server never checks it.

Deleting ACL rules

When you uncheck the “Access control is on” option, you are prompted to 
confirm if you want to erase records in the ACL file. When you click OK, the 
server deletes the entire set of access control rules for that resource.

A less drastic way of deleting an access control rule is to click the Trash can 
icon at the end of each line to delete a single rule.

Response when access is denied
You can choose the response a user sees when denied access. You can vary 
the message for each file or folder. By default, the user is sent a message that 
says the file wasn’t found (the HTTP error message 404 Not Found is also sent). 
In general, do not change this setting without consulting with your server 
administrator. 
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To change the message that is sent for a particular resource when access is 
denied:

1. In the top frame, click the link called “Response when denied.” The Access 
Deny Response form is displayed in the lower frame with the default option 
set.

2. Click the radio button labeled “Respond with the following url.”

3. In the text field, type the URL for the file (text or HTML) in your server’s 
document root that you want to send to users when they are denied access. 
Make sure the file doesn’t contain references to other files (such as style 
sheets) or images because they won’t be sent. 

4. Click Update to return to the top form.

5. Click Submit to set this response as part of the access control rule.

Note Make sure any users who get the response file have access to that file. That is, 
if you have access control on the response file and the user is denied access to 
both the original resource and the response file, the server sends the default 
denied response.

Additional options
Most users do not need the additional ACL features described in this section, 
but there may be cases where you need these features to provide the desired 
level of control for a file or folder. For example, you may need special 
restrictions on personnel directories in the HR group or confidential files 
belonging to the CEO of a company.

Using the Continue option
By default, an access control rule has the Continue option checked. This allows 
lower-level files and folders to have their own ACL rules, which can contradict 
already defined ACL rules. For example, even though an earlier ACL rule allows 
anyone to read all files in a directory, you can define a rule for your files in this 
directory that denies access to everyone but yourself. 
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You could, however, set an ACL rule for a folder that prevents its files from 
having ACL rules that defined access in a different way. This is referred to as 
absolute control, and you set this option by unchecking the Continue 
checkbox. When the server evaluates the access control rules for a resource, it 
stops whenever it encounters a rule that does not have Continue checked. 

For example, suppose someone requests the following file:

http://www.mozilla.com/docs/Project-X/presentation.html

The server checks all ACL rules that affect the object. First it checks any overall 
permissions for the server, then it checks the permissions for the /docs  
directory and then those for the /Project-X  subdirectory. The server 
continues checking ACL rules until it reaches the ACL for the requested URL (in 
this case, the file presentation.html ) or until it reaches an ACL rule that 
has the Continue option unchecked. 

Once an absolute rule is encountered, the ACL defined as of that point is the 
only operative access control rule. You cannot define less restrictive rules for 
files or folders at lower levels of the document tree.

Specifying host names and IP addresses
Although you probably won’t need to do this, you can limit access to files and 
folders by making them available only to people using specific computers. You 
can use wildcard patterns to specify multiple computers or entire networks. If 
you want to use this feature, you must have DNS running in your network and 
your computer must be configured to use it.

Note It’s possible for more than one person to have access to a particular computer. 
For this reason, Host-IP authentication is most effective when combined with 
User-Group authentication. If both methods of authentication are used, the end 
user has to enter a user name and password before getting access.

You specify this restriction by using wildcard patterns that match the 
computers’ host names or IP addresses. For example, to allow or deny all 
computers in a specific domain, you would enter a wildcard pattern that 
matches all hosts from that domain, such as *.netscape.com . 

To specify a host name or IP address, follow these steps:
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1. Click the Anyplace link in the From Host column in the top part of the ACL 
form. The From Host form is displayed in the bottom frame. 

2. In one of the fields under the Only From option, type a wildcard pattern or 
a comma-separated list of hostnames or IP addresses. 

3. Click Update to return to the top part of the ACL form with the new or 
modified data.

4. Click Submit to modify the access control rule.

Restricting by hostname is more flexible than by IP address—if a user’s IP 
address changes, you won’t have to update this list. Restricting by IP address, 
however, is more reliable—if a DNS lookup fails for a connected client, 
hostname restriction cannot be used. 

The hostname and IP addresses should be specified with a wildcard pattern or 
a comma-separated list. The wildcard notations you can use are specialized; 
you can only use the * . 

For IP addresses, the *  must replace an entire byte in the address. That is, 
198.95.251.*  is acceptable, but 198.95.251.3*  is not. When the *  
appears in an IP address, it must be the right-most character. For example, 
198.*  is acceptable, but 198.*.251.30  is not.

For hostnames, the *  must also replace an entire component of the name. That 
is, *.netscape.com  is acceptable, but *sers.netscape.com  is not. When 
the *  appears in a hostname, it must be the left-most character. For example, 
*.netscape.com  is acceptable, but users.*.com  is not.
Chapter 7, Access control 143



144 Netscape Web Publisher User’s Guide



C h a p t e r

8
Managing links
Netscape Web Publisher maintains links between files, updating links automat-
ically as you copy, move, and rename files and directories. The Web Publisher 
link management function can automatically check and update local links in 
HTML documents. 

The Web Publisher link management function considers these types of links:

• internal, or local: HTTP links between files on the same server.

• external: links that point to locations outside the web server. External links 
are to other HTTP servers, to ftp  servers, and to mail and messaging 
systems. 

Note If your server administrator turns link management off for your server, you 
have no access to the link checking function or to the link status database. 
Please check with your server administrator if link management is turned off. 
Note that if link management is turned on again, the link status database is 
empty, and you will have to recheck all files for their current link status.
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Link management actions
Web Publisher link management provides internal link-checking mechanisms 
that take place in the background as part of many Web Publisher operations. 
This section describes what happens behind the scenes.

When an edited file is published

When an edited document is published:

• all internal links are checked

• external links are not checked

When a file is uploaded to the server

When a local document is uploaded to the server:

• all internal links are checked

• incoming external links to file become valid

• outgoing external links are not checked

When a file is copied

When you copy a document or folder:

• all internal links are checked, relative links may become invalid

• external links are not checked

In a copy, the original file still exists, so links pointing into or out of the original fil
are not affected. Outgoing links to other documents on the same server are chec
and fixed by automatic link updating as needed to keep them pointing to the righ

For example, if you copy fileA  from oldFolder  to newFolder , and fileA  has 
a relative link to fileB  in the same directory, the new fileA  will have a link that 
points back to fileB  in oldFolder  rather than try to find a fileB  within the same 
newFolder  directory. That is, a relative link (../fileB ) to another file is 
expanded to include its directory (../ oldFolder/fileB ).

Table 8.1 Link management copy actions 
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When a file is moved or renamed

When you move or rename a document or folder:

• all internal links are checked

• external links are not checked

In a move, the original file no longer exists, so links pointing into or out of the 
original file must be changed to reflect the file’s new location. Links coming in fro
and going out to other server documents on the same server are checked and fi
automatic link updating as needed to keep them pointing to the right file.

For example, if you move fileA  from oldFolder  to newFolder , and fileA  has 
a link to fileB  in the same directory, the new fileA  will have a link that points 
back to fileB  in oldFolder  rather than try to find a fileB  within the same 
newFolder  directory. That is, a relative link (../fileB ) to another file is 
expanded to include its directory (../ oldFolder/fileB ).

Table 8.2 Link management move or rename actions 

Operation File or 
folder?

Incoming or 
outgoing?

Result

Copy Either Incoming No change, links still point to original file.

Copy File Outgoing Links in newly copied file are mapped to point to 
original file targets.

Copy Folder Outgoing within 
same directory

No change to relative links in newly copied file. 
Absolute links are mapped to point to files with 
same names within copied directory. 

Note: If a file with the name file2  exists in the 
new directory, file1  keeps its original relative 
link and does not map back to the old file2 .

Copy Folder Outgoing to 
different directory

Links in newly copied file are mapped to point to 
original files in old directory.
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When a file is being edited

Links to a file in the edit state are operational because you can view edited files i
browser.

Links out of an edited file become invalid when the target file has been moved 
or renamed during the edit. To fix this, you must go in manually and change 
the document yourself. 

When a file is locked

Locks are ignored. Web Publisher can update a file’s links even while it is locked

When a file is deleted

All incoming links become invalid.

Operation File or 
folder?

Incoming or 
outgoing?

Result

Move, rename Either Incoming Links in existing server files are mapped to point 
to new file location or new file name.

Move, rename File Outgoing Links in moved or renamed file are mapped to 
point to original file targets.

Move, rename Folder Outgoing within 
same directory

No change to relative links in newly moved file. 
Absolute links are mapped to point to files with 
same names within moved directory.

Note: If a file with the name file2  exists in the 
new directory, file1  keeps its original relative 
link and does not map back to the old file2 .

Move, rename Folder Outgoing to 
different directory

Links in moved or renamed file are mapped to 
point to original files in old directory.
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Automatic link updating

When you upload or publish a document, Web Publisher’s link management func
checks its links automatically. When you copy, move, or rename files in Web 
Publisher, their links are updated so that they still point to the same documents. 
This is done by automatically updating the name mapping between the old and n
directories. 

By changing a link in a file, this function also changes the file’s latest modificatio
date. In situations where users need to keep close track of any file modifications
server administrator can turn off this option. (This is the default.) 

When this option is turned off, the links in a file are not kept up to date as other f
or folders are moved or renamed. If the option is turned on again, Web Publisher
not return to do any clean-up on files whose links were broken during the time th
option was turned off.

The mapping rules are different for move and copy operations. The link updating
happens the same way for both operations, but the scope of which documents are 
affected is quite different. 

For a copy, only the copied document needs to be updated if it has any invalid 
outgoing links. For a move, any and all server documents with links that point at 
moved document need to be updated in addition to the moved document, if it ha
invalid outgoing links.

Getting link status information
You can get the current status of the links in a file or in all the files within a 
directory. Web Publisher tries to keep links up to date, name mapping as 
needed to point to renamed and moved files and folders. 

Checking links

You can check the status of all the links in a file’s or all the links in all the files 
within a folder. 

There are two ways to check links:
Chapter 8, Managing links 149



Getting link status information
1. Select the file or folder in the Web Publisher window.

2. From the Services menu, choose Check Links. A new browser window 
appears with the file’s link status information displayed.

or, 

from the Web Publisher Services page, choose Check Links. The link status 
information is displayed in the right frame.

3. If you are checking the links in a folder, you can check the “Include 
subfolders” option to include its subfolders and their files.

When Web Publisher finishes checking all the links in the file, the Link Status 
form shows a list of all the outgoing links that are working, broken, or external.

When Web Publisher finishes checking the links in a folder, the Link Status 
page lists all the files within the folder that have outgoing links that are all 
working or that have one or more broken links. The link status of the 
subfolders is nto displayed.

Viewing link status information

The link status information for a file whose links have been verified at least 
once consists of a list of the file’s links with icons indicating the status of each 
link:

Working: The link has been checked and has been found to be a valid, 
operational link to an existing file on the same server. You also see this status 
for files in a folder that do not contain any outgoing links.

Broken: The link has been checked and has been found to be a link that 
targets a file that doesn’t exist on the server with the name and path indicated 
by the link. The link may be a new incorrect link or it may be a link that once 
worked and that now, for whatever reason, no longer works.

External (For files only): The link has been found to be targeting a destination 
that cannot be checked. For example, mailto  and ftp  locations and files or 
folders of external servers cannot be checked by Web Publisher.

Unchecked (For folders only): The links in this file within the folder have not 
yet been checked.
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Checking a file’s links

To check the outgoing links in a file, do the following:

1. Select a file and view its properties in the Web Publisher Services menu.

2. Click the Check Links button. 

An updated link status list for the file’s outgoing links is displayed. 

Checking a folder’s links

To check the links for a folder, do the following:

1. Select a folder and view its properties in the Web Publisher Services menu.

2. Click the Check Links button. 

3. You can include the subfolders in the link checking. The default is to not 
check the links in the subfolders.

The link status for all the files in the folder is updated and the files are listed, 
with a notation indicating whether there is any broken or external outgoing link 
in the file. If there is a single broken link, the broken link icon (X) is displayed.

Note When link management is turned off for your server and then turned back on 
again, the link status database is empty. You can recreate a complete link status 
database by checking the links for your document root with the “Include 
Subfolders” option selected.

Finding broken links

To find out if there are any Web Publisher documents with broken links in a 
particular folder, do the following:

1. Select a folder in the Web Publisher window.

2. To make sure your link status database is up to date, begin by using the 
Check Links function for the folder (with Include Subfolders selected).

3. From the Services menu, choose Find Broken Links.
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Web Publisher looks in the link status database to identify any file that contains 
one or more broken outgoing links and displays a list of these files, as shown 
in ff.

Figure 8.1  Finding broken links 

For each file in the list, Web Publisher provides

• the file’s URL, so you can view it in your browser and edit it to resolve the 
broken links

• an icon for Check Links, so you can check the file’s latest link status 

• an icon for the Web Publisher Services page, so you can view the file’s 
properties
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